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Context-Sensitive Help Preferences

This procedure explains how to change your help preferences in TIBCO Business Studio™
for BusinessWorks™ to access context-sensitive help from a local directory or from an
internal web server where you have placed the documents.

Before you begin

To set context-sensitive help preferences, you must first download the product
documentation from the FTP site provided by your TIBCO representative. Copy the
documentation .zip file to a local directory, or to an internal web server and then extract
the file.

Procedure
1. In TIBCO Business Studio for BusinessWorks, click Window > Preferences. On
macOS, click TIBCO Business Studio > Preferences.

2. In the Preferences dialog box, click BusinessWorks > Help.

3. Select Custom Location and then click Browse to select the html directory where you
extracted the documentation, or provide the URL to the html directory on your
internal web server.

4. Click Apply and then click OK.
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New Features

The following new features are available in this release of TIBCO ActiveMatrix

BusinessWorks™.

Release 6.8.1

Common Features

Ability to share Smart
Mapper Learning via
externalized database

Support for "allOf" keyword
in Swagger files

Support for parsing the
Swagger files with the special
characters @ and #

A new field activityTimeout
under
dynamicConfigurations
element is added.

Support to refer to the
external JSON from
OpenAPISpecification 3.0
JSON file

Creation of a web service
with one-way operations
returning faults is supported

With this version, you have the capability to connect the
Smart Mapper to an externalized database to be able to share
learning done on one machine within your team to achieve an
improved collaborative team development experience.

You can now generate XSD and create a top-down service or
reference binding using an existing JSON file with "allOf"
keyword for request and response schemas.

Support is provided to parse the Swagger files having element
names with the special characters @ and # in the request and
response schema objects.

A new field activityTimeout under dynamicConfigurations
element is added to the Input tab of the REST Invoke activity
created with a reference binding. Provide the value in
seconds. At runtime, it takes precedence over the Activity
Timeout value on the Advanced tab.

Support is added to generate XSD and create service and

reference binding using OpenAPISpecification 3.0 JSON file,
which refers to an external JSON file.

Support is added to use One-Way operation along with Fault
replies.
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Common Features

Support to enforce
authentication on REST
Reference binding using the
Authentication check box on
the HTTP client shared
resource

Administration

Encryption/Decryption of
profiles supported via REST
API

Runtime

Support added for
Concatenated system
Module Properties

The iterate loop variable
resets after each iteration

Design Time

Configure the REST
Endpoints in Cloud Mesh
via CICD.

Send the password digest
while using

UserNameToken.

Add Custom Xpath

You can now enforce basic authentication on REST Reference
binding using the Authentication check box on the HTTP
client shared resource. The Authorization header for the same
is reflected in the outbound request.

This release adds support to encrypt or decrypt profiles via
provided REST API to enhance encryption of profiles feature.

On adding new Concatenation feature properties, properties
referencing other properties are displayed as Undefined under
Admin UL.

Variable inside iterate loop resets now after each iteration when
you set the property to bw.engine.enable.loop.reset=true.

You can configure and override the TIBCO Cloud Integration

Cloud Mesh Resource Endpoints during the deployment process.

Now you can send password digest while using UserNameToken
for security in the SOAP Policy.

You can now add Custom Xpath function as a module

TIBCO ActiveMatrix BusinessWorks™ Release Notes
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Design Time

function as a module
dependency.

You can run an application

using TIBCO Cloud Mesh

with Single Sign On option

selected.

Support is provided to
connect to TIBCO Cloud
Integration from TIBCO
Business Studio for
BusinessWorks using
Single Sign-On (SSO).

Support for Assertion of
activities within a group

Support for mocking of
activities within a group
Palettes

Nested

mimeEnvelopeElement is
visible and supported.

Support to provide a custom

boundary for multipart
content type

dependency in pom.xml using TIBCO ActiveMatrix BusinessWorks
Maven plug-in.

When you select the Single Sign On option from Preferences and
run an application with TIBCO Cloud Mesh service, you can
select the Enable TIBCO Cloud Mesh Services Consumer check
box available under Run > Run configurations... > Advanced
Tab or Run > Debug Configurations... > Advanced Tab.

This release adds support to connect to TIBCO Cloud Integration
from TIBCO BusinessStudio for BusinessWorks using Single Sign-

On for enhanced authentication.

Note: At a time you can use only one method, either SSO
Login or Password Grant, to connect to the cloud application.

This release adds out of the box support for adding assertions to
the activities within a group in a process.

Support for mocking activities within a group is now provided.

Now nested mimeEnvelopeElement is visible and supported in
the Input and Output schemas of the HTTP palette activities.

Support is provided to add the custom boundary for multipart
content type on the Send HTTP Request and Send HTTP
Response activities.
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Release 6.8.0

Common Features

Support is added to
remember mappings
made in a smart
mapping session.

Out of the box support
provided for TIBCO
ActiveMatrix
BusinessWorks™ plug-in
for Apache Maven

Support is added for
Java 11.

Support added for
module property for the
OAuth Configuration
shared resource.

Support is provided for
form parameters for
OpenAPISpecification
3.0.

ActiveMatrix BusinessWorks now remembers mappings made
during a smart mapping session and provides recommendation for
mapping elements.

For more information, see "Smart Mapper" in TIBCO ActiveMatrix
BusinessWorks™ Application Development.

The ActiveMatrix BusinessWorks installer now includes the installer
of TIBCO ActiveMatrix BusinessWorks™ plug-in for Apache Maven.

Now TIBCO ActiveMatrix BusinessWorks™ 6.8.0 supports Java 11 on
the Windows, Mac, and Linux platforms.

This release adds support for module properties for the following
fields of the OAuth Configuration shared resource:

e Cliend ID

e Client Secret

e Access Token URL
e scope

e Username

e Password

e Confidentiality

REST service binding and REST reference binding now support form
parameters for OpenAPISpecification 3.0.
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Common Features

Support for dynamically
overriding binary
response format

Support is added for
setting the request URL
dynamically on REST
reference binding

Support is added for
handling runtime
expressions in Callback
URL

The Description field is
added on the REST
service binding.

The SOAP Invoke
activity now sends
requests with CDATA
tags.

Support of Binary
Response Format for

You can override the binary response format only when
"application/octet-stream" is selected in the Response Media Type
using Content-Type Response Header on the Reply activity. Select
the Use HTTP Headers check box and then pass the value in the
Reply activity. The same value is reflected at runtime in the
Response headers content-type.

The dynamicConfigurations field is added on the Input tab of the
Invoke activity, which is used for invoking REST service with REST
reference binding. The dynamicConfigurations consists of the
following information:

URL: The endpoint URL to override from reference binding.

Note: This field is visible for newly created reference binding
only.

When you drag a callback URL with runtime expressions from a
OpenAPISpecification 3.0 file to create a REST service or a reference
binding, the Resource Service Path is set to /callback and the
shared resources have localhost and 8080 as Host and Port values
respectively.

The Description field is added on the REST service binding for all
the parameters. Set the description in TIBCO Business Studio for
BusinessWorks and the same value is reflected in Swagger Ul when
you refresh the Swagger Ul URL.

Request with CDATA tags can now be sent with SOAP Invoke
activity.

For the CDATA tags to remain intact on the wire, set the following
Java property in VM arguments:

bw.binding.soap.invoke.cdata.serialization=true

The Binary check box is added in the Response Format for
OpenAPISpecification 3.0 service and reference binding.
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Common Features

OpenAPISpecification
3.0 REST services is
provided.

Support added for
implementing callbacks
in OpenAPISpecification
3.0.

REST service can return
HTML content to the
browser.

Enhancements are
made in Unit testing
and Mocking support.

Design Time

Generate Manifest.json file
for TIBCO Cloud projects
using bwdesign.

The Use local time
option is provided in the
Timer activity.

You can now create REST service or reference bindings from a
JSON file containing a callback URL.

REST service can return HTML content to browser by passing
"text/html" as Content-Type header value in the response headers
of the Reply activity. Select the Use HTTP Headers check box and
Format as Text on the Response tab of REST service binding.

ActiveMatrix BusinessWorks adds support for Mocking and unit
testing for the following entities:

* Main process activities
» Events or process starters
» Service Binding

o SOAP service implemented as a constructor operation

Now you can generate Manifestjson file for TIBCO Cloud projects by
using the following bwdesign command line utility:

generate_manifest_json -project <project_name> <location to generate
manifest.json file>

The Use local time check box is added on the General tab of the
Timer activity. If you select the check box, the timer is triggered at
the specified Start Time value of a system from which an
application is deployed.
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Design Time

The temp files are no Now the Git Staging tab does not show the temp files in the
longer showed under Unstaged Changes section after committing the changes.
Unstaged Changes.

The temp files are added Now the temp files are added to the .gitignore file.
to the .gitignore file.

Successful installation of  Now you can successfully install AWS CodeCommit Plugin by
AWS CodeCommit Plugin  following these steps:

1. Install Guava: Google Core Libraries for Java 21.0 from here.
2. Install Eclipse Equinox Target Components from here.
3. Install M2E from here.

4. Install AWS Code Commit from here.

The View The plug-ins in the Plug-in Manager now display a View
Documentation icon is Documentation icon. Click the icon to view the corresponding
added for plug-ins in plug-in's documentation on docs.tibco.com

Plug-in Manager

Support is added for If a Swagger file has "default" as one of the responses for REST
"default" response service's operation, then on creating a top-down REST service
in REST Service. from the Swagger file the same is reflected in the Response

Status tab of REST service binding.

To Reply with default fault, you must add the statusCode element
to the default fault schema. Use the following steps :

1. Open the REST service process.
Click on OnMessage Start > Properties > Fault tab.

Select defaultResponseSchema

e

Add statusCode as an Integer type element

If the statusCode element is already present in the default response
schema, then do not add the element.

TIBCO ActiveMatrix BusinessWorks™ Release Notes
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Design Time

Support is added for

TIBCO Business Studio for BusinessWorks is now based on Eclipse

Eclipse 4.19 platform for ~ 4.19 platform.

TIBCO Business Studio
for BusinessWorks

Palettes

Support is added
for TLS session
resumption

Support is added to
allow or restrict IP
addresses in the
HTTP Connector
shared resource.

For more information, see "Eclipse 4.19 - New and Noteworthy"
page on the Eclipse's site.

All activities from the FTP palette now support TLS session resumption
on the data connection.

The following VM arguments are added in TIBCO Business Studio for
BusinessWorks to allow or restrict IP addresses.

e Dbw.plugin.http.httpConnector.allowIPs=<IP address>
e Dbw.plugin.http.httpConnector.restrictIPs=<IP address>

You can provide a list of IP address by using a semicolon (;) as a
separator.

For example:
Dbw.plugin.http.httpConnector.allowlPs=10.98.179.102;10.98.179.110.
In this example, both IP addresses 10.98.179.102 and 10.98.179.110 are
allowed.

Use a hyphen to provide a range of IP addresses.

For example: Dbw.plugin.http.httpConnector.restrictIPs=10.98.179.102-
10.98.179.110.

In this example, IP adresses 10.98.179.102 to 10.98.179.110, both
inclusive are restricted.

You can also provide a range of IP addresses along with other IP
addresses not in the IP address range separated by semicolons.

For example: Dbw.plugin.http.httpConnector.restrict|Ps=10.98.179.102-
10.98.179.110;10.98.179.120.

Use a hyphen to provide a range of IP addresses.
For example: Dbw.plugin.http.httpConnector.restrict|Ps=10.98.179.102-

TIBCO ActiveMatrix BusinessWorks™ Release Notes
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Palettes

The performance of
JDBC palette
activities is
improved.

Support is added
for TLS 1.3 version.

Support added for
Module Properties
for additional
configuration.

10.98.179.110.
In this example, IP adresses 10.98.179.102 to 10.98.179.110, both
inclusive are restricted.

Set the following VM arguments :
¢ -Dbw.application.jdbc.validateConnection.frequency=55

The frequency means how often to check connection validity when
inside the pool. This value must not be above the Connection Idle
Timeout property in the JDBC Connection shared resource.

e -Dbw.application.jdbc.validateConnection=false

Check whether to validate the connection prior to sending it to the
activities.

The shared resources for SSL Server Configuration and SSL Client
Configuration now support TLSv1.3 as SSL Protocol version for HTTP,
REST, SOAP, Mail and TCP Palettes. TLS 1.3 supports only RSA
certificates.

For more information, see "SSL Server Configuration" and "SSL Client
Configuration" in TIBCO ActiveMatrix BusinessWorks™ Binding & Pallete
Reference.

* You can use a module property for configuring Confidentiality
on HTTP Connector shared resource.
For more information, see "Security" in TIBCO ActiveMatrix
BusinessWorks™ Binding & Pallete Reference

* You can use a module property for providing the HTTP
Connector Name on SOAP service binding.
For more information, see "Configuration for HTTP Transport" in
TIBCO ActiveMatrix BusinessWorks™Binding & Pallete Reference

TIBCO ActiveMatrix BusinessWorks™ Release Notes
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Runtime
Smart You can now generate various HTML reports for the engine data collected for
Engine different performance use cases. Smart engine also analyzes the engine data

collected and provides recommendation to improve performance of your

application.

For more information, see "Smart Engine" section in TIBCO ActiveMatrix
BusinessWorks™ Administration.

Release 6.7.0

Common Features

Smart Mapper

This release adds support
for OpenAPISpecification
3.0.

Encryption and
decryption of application
profiles.

Smart Mapper provides the ability to intelligently determine how
data is to be mapped in the activity's input tab.

e REST Service Binding: Now you can create and implement
a REST Service defined with OpenAPISpecification 3.0,
using both: the Swagger file as well as ActiveMatrix
BusinessWorks™ REST Service Wizard.

e REST Reference Binding: You can invoke the REST APIs
created using the OpenAPISpecification 3.0, with the REST
Reference Binding, and Invoke REST API activity.

» Updation to Swagger Ul: OpenAPISpecification 3.0
support is added to the Swagger Ul, which supports the
Swagger 2.0 and OpenAPISpecification 3.0. On invoking the
REST 3.0 service from Swagger Ul, the runtime Swagger is
generated as per OpenAPISpecification 3.0.

Note: The OpenAPISpecification 3.0 JSON file containing
OpenAPISpecification 3.0-specific features, which are not in
parity with the Swagger 2.0 JSON file, is not supported.

ActiveMatrix BusinessWorks provides capability to encrypt
complete application profiles which can be decrypted while
debugging and at runtime. It helps to increase security for
application properties containing confidential information.

TIBCO ActiveMatrix BusinessWorks™ Release Notes
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Common Features

Now you can capture the
details of query
parameters sent as a part
of the incoming request
to a REST service.

A namespace prefix is
now added for SOAP RPC
Literal response.

New error code to
represent SOAP
Undeclared Client Fault

Support is added for
OAuth 2.0 configuration

For more information about encrypting profiles in TIBCO Business
Studio™ for BusinessWorks™, see "Encrypting an Application
Profile" in TIBCO ActiveMatrix BusinessWorks™ Application
Development.

For more information about handling encrypted profiles securely
at the administration side, see "Configuring Application Archives"
in TIBCO ActiveMatrix BusinessWorks™ Administration.

Set the following logger in the logback.xml file :

<logger name="com.tibco.bw.binding.rest">
<level value="DEBUG"/>
</logger>

The response received from SOAP RPC Literal service was
malformed. Hence the namespace prefix is prepended to the
Response element.

The TIBCO-BW-BINDING-SOAP-550101 error code is displayed on
the Invoke activity on receiving Undeclared Client Fault in
response from a SOAP service. In case of server error, the error
code TIBCO-BW-BINDING-SOAP-550100 is displayed.

For more information, see "SOAP Binding Error Codes" in the

TIBCO ActiveMatrix BusinessWorks™ Error Codes .

This release adds support for OAuth 2.0 configuration on HTTP
Client shared resource for getting OAuth access and refresh
token.

It also adds ability to include access token in outbound REST
reference.

A new OAuth Configuration shared resource is added.

For more information, see "OAuth Configuration Resource" in
TIBCO ActiveMatrix BusinessWorks™ Bindings and Palette
Reference.

TIBCO ActiveMatrix BusinessWorks™ Release Notes
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Common Features

Plug-in manager

Administration

Ability to refresh the
status of an

application instance.

Ability to collect and
download AppNode
data.

Support is added for
MySQL 8.x.

You can now install and uninstall TIBCO ActiveMatrix
BusinessWorks™ plug-ins from TIBCO Business Studio for
BusinessWorks in more simplified way using Plug-in manager.

For more information, see "Installing Plug-ins using
BusinessWorks Plug-ins Manager" and "Uninstalling Plug-ins using
BusinessWorks Plug-ins Manager" in TIBCO ActiveMatrix
BusinessWorks™ Installation.

The Refresh Agents button is added on page 1 and page 2 of Agents
on the Admin UL.

This button refreshes the status of all Applinstances and AppNodes
running on that particular agent.

The new Appnode Data tab is added on the AppNode Level 2 page.

For more information, see "Auto Collecting Engine Data" in TIBCO
ActiveMatrix BusinessWorks™ Administration.

ActiveMatrix BusinessWorks™ now supports MySQL 8 database. The
options to install the available versions of the driver are listed on the
command line interface.

Note: You can install only one version of the driver at a time. If
you want to install new version, the previously installed driver
version is overridden.

To install the driver for Mysqgl database, use the bwinstall command
line utility as follows:

bwinstall mysql-driver

To uninstall the driver for Mysql database, use the bwuninstall
command line utility as follows:

TIBCO ActiveMatrix BusinessWorks™ Release Notes
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Administration

Support is added to
dynamically update
flow limit.

Design Time

Visual Diff

bwuninstall mysql-driver

For more information, see "Using MySQL 8.x Database" in TIBCO
ActiveMatrix BusinessWorks™ Installation.

This release adds support to dynamically update the flow limit from
the Application level 2, AppSpace level 2, and AppNode level 2 pages
of the Admin UL.

You can also update the flow limit using the REST APIs.

For more information, see "Engine and Job Tuning" in TIBCO
ActiveMatrix BusinessWorks™ Administration

You can compare two revisions of a process and its artifacts side by
side visually in TIBCO Business Studio™ for BusinessWorks™. It
highlights changes in newer revision such as addition or removal of
activities, changes in an activity configuration.

You can compare the application properties sections of two
projects and difference between the two profiles of the same
project.

You can compare the module properties sections of two
projects.

This feature supports the visual difference for encrypted
profiles.

You can compare two revisions of a process.
You can compare shared resources.

It provides integration with GIT and SVN to compare revisions
stored in a version control system along with local revisions.

For more information, see "Diff Viewer" in TIBCO ActiveMatrix

TIBCO ActiveMatrix BusinessWorks™ Release Notes
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Design Time

Sorting functionality
is available for roles.

Custom Icon is now
introduced for Call
Process and Java
Invoke activities.

Support is provided
for module property
for the Client ID on

the JMS Connection.

Support is added for
application
templates.

BusinessWorks™ Application Development

Now you can move the rows up or down and sort the roles in
ascending or descending order.

The Custom Icon field is added on the General tab for the Call
Process and Java Invoke activities.

For more information see "Call Process" and "Java Invoke" in TIBCO
ActiveMatrix BusinessWorks™ Bindings and Palettes Reference.

For more information on how to add the custom icons, see "Adding
Custom Icons" in TIBCO ActiveMatrix BusinessWorks™ Application
Development.

You can use a module property for the Client ID on a JMS
Connection resource.

Ability to import and export pre-designed application templates
designed with best practices and pre-configured processes, shared
resources, modules etc.

It helps improve collaborative development experience and
reusability where team members can design their applications using
application templates.

You can perform the following operations:
e Export an existing project as a template.
e Create a project using a template
* Modify an existing template.

For more information, see "Working with Templates" in TIBCO
ActiveMatrix BusinessWorks™ Application Development.
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Palettes

The ResourcePath element is added on
the Input tab of the Invoke REST API
activity.

Support is added for PostgreSQL
failover URL.

The Loop Subset in Current Process
check box and the Loop Subset in
Calling Process field are added on the
Advanced tab of the JDBC Query
activity.

A new Interpret Invalid XML Chars
check box is added on the Advanced
tab of the JDBC Query activity.

Now you can enable Debug level logs
for the Parse JSON and Render JSON
activities.

Support is added for the square
bracket ([]) in the resource path.

An additional element ResourcePath is added on the
Input Tab of the Invoke REST API activity for
overriding the Resource Path value on the General
tab of the activity.

Support is added for PostgreSQL failover URL. For
example:

jdbc:postgresql://host1:port1,host2:port2/database

These options are enabled only when the process in
subsets is selected.

For more information, see "JDBC Query" in TIBCO
ActiveMatrix BusinessWorks™ Bindings and Palettes
Reference.

Select the check box to avoid getting problems with
illegal chars.

Now the input and output for the Parse JSON and
Render JSON activities are logged when the
Schema Type is selected as XSD on the General
tab, by enabling Debug level logs.

Add the following logger in the logback.xml file :

<logger name="com.tibco.bw.palette.restjson">
<level value="DEBUG"/>
</logger>

You can pass a query parameter having the square
([1) bracket in the Invoke REST API activity's
Resource Path field on the General tab or Input
tab using percent-encoding for ? as %3F.
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Runtime
Support is added This release adds the ability to collect activity instance and process
to collect activity data instance.

instance and
process data
instance.

The activity instance and process instance data is collected from the
AppNode and is stored in a database. The data can be queried by using
REST APIs to find maximum time consuming and maximum memory
consuming activities and processes.

For more information, see "Collecting Performance Parameters with
respect to Activities and Processes" in the TIBCO ActiveMatrix
BusinessWorks™ Administration.
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Changes in Platform Support

In this release, platform support for ActiveMatrix BusinessWorks has changed as follows:

Platforms Status As of Release
Apple Mac OS 12.x Added 6.8.1
Oracle 11g and 12c databases Removed 6.8.1
Apple Mac OS X 10.13.x, 10.14.x 64-bit on x86-64 Removed 6.8.0
Apple Mac OS X 11.x 64-bit on x86-64 Added 6.8.0
Microsoft Windows 8 64-bit on x86-64 Removed 6.8.0
Microsoft Windows Server 2012 64-bit on x86-64 Removed 6.8.0

Novell SUSE Linux Enterprise Server 11.x 64-bit on x86-64 Removed 6.8.0

For a complete list of all the currently supported platforms, see the readme file.
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Changes in Functionality

The following functionality-related changes have been made in this release.

Release 6.8.1

General

Updated spring
framework libraries
for Eclipse.

Upgrade the JDK
compiler
compliance version
to the one greater
than 1.5.

The spring framework libraries for Eclipse are updated to address the
vulnerability issues.

The minimum JDK compiler compliance required is 1.5. If the project
that you are importing with Java nature has JDK compiler compliance
less than 1.5, you can choose to upgrade the JDK compiler compliance
version to the one greater than 1.5.

Binding

Support is Earlier for invoking REST services configured with Basic Authentication Policy
added for from Swagger Ul, you had to provide the Username and Password in the
Authorize provided input fields and click the Explore button. Now you can use the
button on Authorize button and provide the login details.

Swagger Ul

Runtime

Password Digest option is You can choose the password type as Password Digest when

provided in SOAP Reference. using the UserNameToken for security in SOAP Reference.

TIBCO ActiveMatrix BusinessWorks™ Release Notes



23 | Changes in Functionality

Palette

Improved error message for
SOAP Client using HTTP and

HTTPS

Release 6.8.0

Administration

Support is added to
enable and disable
OpenTelemetry from
Admin CLI and Admin
ul.

Change in the
content arrangement
in a backup .zip file.

Change in the default
transport layer.

General

Change in the
default setting
of the Always

Earlier, while invoking a service using HTTPS, the error
message returned by invoke was not very useful to identify
the problem.

Now, an improved error message occurs for SOAP Client
using HTTP and HTTPS.

Earlier, support was added to enable and disable OpenTracing from
Admin CLI and Admin UL.

Now, the support is added for OpenTelemetry.

Earlier, while backing up profile, an application profile name used to
change to profile_<application_name><application_version>.substvar
and for appinstance, it used to change to profile_<application_
name><application_version>_<appnode_name>.substvar

Now, in backup .zip file, all the artifacts are arranged in a folder to
maintain exact configurations.

Earlier, the default transport layer between the BWAgent and the
AppNode was UDP.

Now, the default transport layer is REST.

Earlier, the Always run in background check box located at Window >
Preferences > General was clear by default.
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General
run in Now, the Always run in background check box is by default selected.
background .
Clear the check box to view progress bars for some events.
check box.
Palette

A new JMS Fetch A new JMS Fetch Timeout field is added on the Advanced tab of the
Timeout field is Get JMS Queue Message activity.

dded.
adde Additionally, the behavior of the timeout field on the Input tab is

changed. For more information, see "Get JMS Queue Message" in TIBCO
ActiveMatrix BusinessWorks™ Binding and Palette Reference.

Support is added Earlier, you could collect traces by using OpenTracing.
for OpenTelemetry

to collect traces. Now, you can collect traces by using OpenTelemetry.

For more information, see "OpenTelemetry" in TIBCO ActiveMatrix
BusinessWorks™ Administration.

Release 6.7.0

Administration

Change in the default log level of the  Earlier Jetty, Jersey, and MSSQL server (if applicable)
Jetty, Jersey, and MSSQL server (if logs were available under the BWAgent log when
applicable) logs. started in Debug mode.

Now by default, only Warn level logs are present.

You can change the log level of loggers present in the
bwagent_logback.xml.

General

The Earlier the TIBCOBusinessStudio.ini file was present inside
TIBCOBusinessStudio.app folder.
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General

TIBCOBusinessStudio.ini
file is present at the
/studio/4.0/eclipse folder
location on Mac
operating system.

Change in the
deployment method
name

Change in a way to

discover application
server URL.

EGIT plug-in installation

Migration

Addition of the module
name as a prefix to the
custom Xpath function

Now from TIBCO ActiveMatrix BusinessWorks™ 6.7.0, the
TIBCOBusinessStudio.ini file is present under eclipse folder.

The name of the deployment method is now changed from
"Appspace" to "BW Appspace".

When TIBCO ActiveMatrix BusinessWorks™ application with REST
reference and with Mesh service client enabled was launched from
TIBCO Business Studio™ for BusinessWorks™, the application
invoked a Mesh service from the application on an application
server. The application server's URL was determined by fixed rules.

After a fully-qualified domain names (FQDN) service is provided,
when the ActiveMatrix BusinessWorks™ application is launched,
TIBCO Business Studio for BusinessWorks accesses the FQDNs and
discovers the application server URL from it using a domain URL.

There is no need to install EGIT plugin manually.

EGIT plug-in version 4.4.1 is now a part of TIBCO Business Studio
for BusinessWorks itself.

To verify the installation, navigate to Help > Installation Details >
Plugins (Egit).

Earlier, after migration, the customxpathfunction jar-name did not
have prefix of the module name in it and it migrated as a plain
customxpathfunction jar for the custom Xpath functions.

Now, the CustomXpathFunction jar that is generated by the
migration tool contains the name of the module as prefix before
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Migration

the customxpathfunction jar name.

For example, in SampleApplication_CustomXpathFunction jar,
SampleApplication is the module name.
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Deprecated and Removed Features

This section lists the features that have been deprecated or removed in this release.

Deprecated Features

Release 6.8.1

» Writing Process Statistic Data to an External Database using logback file is
deprecated.

e The Password Grant feature is deprecated.

e The Analyzer feature is deprecated.

Deprecated Features
Release 6.8.0

e TLS vl and TLS 1.1 support is deprecated.

e Support for third-party JMS drivers which are JMS 1.1 compliant by using the Custom
JMS driver approach is deprecated.

Release 6.7.0

e The Universal Installer for TIBCO ActiveMatrix BusinessWorks™ will not include out of
the box support for SVN from the next release. TIBCO will provide a separate
documentation with respective release on how to install the SVN plug-in.

* Maven plug-in will not be shipped with ActiveMatrix BusinessWorks™ 6.x. Maven plug-
in installation option from the bwinstall scripts is removed.

Removed features

Release 6.8.1

No feature has been removed from this release.
Release 6.8.0

With TIBCO ActiveMatrix BusinessWorks™ 6.8.0 release, OpenTracing libraries are removed.
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TIBCO ActiveMatrix BusinessWorks™ 6.8.0 now includes OpenTelemetry support for tracing.
All OpenTelemetry compliant service providers can be integrated to show traces for
ActiveMatrix BusinessWorks applications.

For more information, see the "OpenTelemetry" in TIBCO ActiveMatrix BusinessWorks™
Administration.

ActiveMatrix BusinessWorks removes out-of-the-box support for SVN.
Release 6.7.0

No feature has been removed from this release.
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Closed Issues

The following are the closed issues in this release of TIBCO ActiveMatrix BusinessWorks™.

The closed issues are grouped by components:
e Administration
e Binding
e Core Design Time
e Core Run Time
e General
e Migration
e Palette

e Policies

Administration

This topic lists the closed issues related to Administration.

Release 6.8.1

Key Summary

AMBW-45498 Now the TEA Activity Instrumentation Panel can
display all the activities.

AMBW-45121 The database query to update the Applinstance status
has been optimized to improve database
performance.

Release 6.8.0
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Key

AMBW-
44051

AMBW-
42939

AMBW-
42938

AMBW-
42899

AMBW-
42130

AMBW-
34574

Release

Key

AMBW-
40946

AMBW-
40794

AMBW-
40712

AMBW-
40586

AMBW-
40027

Summary

The database query to update the Applnstance status has been optimized to
improve database performance.

A BWAgent fails to start when using SSL with wildcard certificates.
The process id value for an AppNode present in the output of an API server URL
does not change even if you restart the AppNode.

The BWAdminDataManager is not yet initialized error is displayed when you try to
update the profile using the bwadmin config command with -cf option.

The BWAgent's query working with TEA uses bind variables in the query on the
Oracle database.

There was a harmless warning when starting BWAgent.

6.7.0

Summary

User were not able to download the Log and Logback files from Admin Ul.

The swagger response was different than the actual response of the Deploy
Application API.

The Javascript core libraries are updated to the latest version.

The Get Application Status REST API displayed the 500 internal server error when
an application was in the Starting state.

Updating the Password field from Admin Ul was not working when the provided
password had the percentage character (%).
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Key

AMBW-
39972

AMBW-
39511

AMBW-
37423

AMBW-
36613

AMBW-
34574

Summary

The application instance properties could not be restored to their original values
when they were modified through Admin Ul.

Create domain at the custom location was not working from REST API.
After upgrading, too many unnecessary errors were displayed when starting the
BWAgent.

The upload and deploy profile took too much time.

There was a harmless warning when starting BWAgent.

Binding

This topic lists closed issues related to Binding.

Release 6.8.1

Key

Summary

AMBW-45639  When Invoke activity with REST Reference binding is

configured with absolute file path for multipart form
parameters, it deletes the files that are passed as mimePart
input.

AMBW-45520  For bypassing the version validation in TIBCO Business Studio

for BusinessWorks for swagger files having openapi version
other than 3.0.0, pass the property
bw.plugin.rest.disableOpenApi3xVersionValidation=true in the
TIBCOBusinessStudio.ini file.

AMBW-45399  The application fails to start intermittently and throws an error
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Key

AMBW-45155

AMBW-45154

AMBW-45153

AMBW-43403

Release 6.8.0

Key

AMBW-43816

AMBW-43397

AMBW-43238

Summary
"TIBCO-BW-SCHEMA-RESOLVER-500201: WSDL not found".

The Runtime Swagger file does not include enumeration
restrictions which are defined in a request and response XSD
configured with the REST service.

The Runtime Swagger file of a REST service has optional
extension elements declared in the XSD as required.

The Runtime Swagger file does not include field length
restrictions which are defined in a request and response XSD
configured with the REST service.

The XSD generation, and Service or Reference binding creation
operation are no more blocked, by avoiding parsing of
"#/components/examples".

Summary

For REST application deployed on an AppNode, the bw-
flowlimit-executor-provider threads are not destroyed and
keep on increasing even after starting and stopping an
application.

You can now decide whether to send SOAP headers or not in
the SOAP Envelope of the service. Set the -
Dbw.binding.soap.client.invoke.send.headers property as a VM
argument in TIBCO Business Studio for BusinessWorks or in
the config.ini file to false to stop sending SOAP headers.

By default, the property value is set as true.

Empty header is passed in response in the SOAP envelope
even if you don't configure the SOAP service with Headers.

To not send empty headers set the property
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Key

Summary

bw.binding.soap.client.reply.empty.header.override=true.

AMBW-42775  The "definitions" section in the runtime Swagger file does not

show the type as "array" for the child properties of an object
when you run a REST service configured with a complex
element in an XSD, and the element's definition in the XSD
contains <xs:extension> element with base attribute and array-
based sub-elements.

AMBW-42550  The operationID field is now displayed in the runtime Swagger

file of a REST service when it is hit from Swagger Ul.

AMBW-42313  The Configure Local Swagger option does not work when you

import a project in TIBCO Business Studio for BusinessWorks
first and then configure the Local Folder path in the API
Explorer tab.

AMBW-27634  The null pointer exception is thrown while adding the SOAP

Unbound Headers.

Release 6.7.0

Key

AMBW-
41468

AMBW-

41299

AMBW-
41129

Summary

After migration, the org.apache.axiom.om.OMException: Unable to determine
SOAP version error occurred when an attachment style was MTOM.

Add the following property:

bw.binding.soap.client.reply.mtom.contenttype.override=true.
The unbound header parts were missing in the concrete WSDL generated at
design time using the Generate Concrete WSDL option from SOAP service, which

imported another WSDL importing request and response header XSDs.

The Apache Axis2 threads were not increased with an increase in load.
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Key Summary

AMBW- The Unbound Header parts were missing in the runtime concrete WSDL retrieved
40680 from SOAP service with version 1.2.

AMBW- The Unbound Header parts were missing in the runtime concrete WSDL retrieved
40679 from a SOAP service when the abstract WSDL imported another WSDL, and the

WSDL imported request and response header XSDs.

AMBW- The Send HTTP Request activity could not send the request with Content-type as
40484 multipart/form-data to ServiceNow with Apache HttpComponents library.

Send the POST request using the Jetty HTTP Client library in the HTTP Client

shared resource.

AMBW- The incorrect error code 403 Forbidden was thrown for the Invoke activity in a
39997 SOAP over HTTP application when the HTTP Client shared resource was
configured with the following options:

e Default port = 443

* Implementation Library = Apache HttpComponents(Supported by HTTP 1,
SOAP and REST)

¢ Default Confidentiality check box was selected.
AMBW- The time required for runtime concrete WSDL retrieval for a SOAP service
39819 increased if more applications with a large number of schemas were deployed on
the same AppNode.
AMBW- The runtime concrete WSDL took too much time to generate when an endpoint

39038 was hit in the browser, because the schema cache was not initialized before
WSDL retrieval.

Core Design Time

The following issues have been fixed in this release of TIBCO ActiveMatrix BusinessWorks™.
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Release 6.8.1

Key Summary

AMBW- For certain projects, TIBCO Business Studio for BusinessWorks displays a

45923 misleading error in the Problems tab as follows:
Inline schema is not cloned correctly.

AMBW- The Keystore Provider URL field when mapped as a module property continues to

45716 throw an error even when user corrects a previous invalid/incorrect value. Now a
warning message is shown for this field irrespective of the mapping being module
property or literal value.

AMBW- Whenever there are multiple transitions to the End activity, a new variable with

45682 an optional error report type is created and that variable takes precedence over
the normal error variable.

AMBW- An error is thrown when you try to start an application when using the remote

45326 debugging feature in TIBCO Business Studio for BusinessWorks.

AMBW- Selecting the Generate Process Diagrams check box does not generate the

42932 process diagram in the application module.

AMBW- When there are validation errors in a ActiveMatrix BusinessWorks application, they

36625 are not reported by the bwdesign utility when using the Validate option.

AMBW- You can use TIBCO ActiveMatrix BusinessWorks Maven plug-in to integrate the test

28561 reports, which are generated with the CI/CD tools like Jenkins.

Release 6.8.0
Key Summary
AMBW-44487 While performing the Push to Cloud action from TIBCO
Business Studio for BusinessWorks, the EAR generation
operation does not time out for large projects.
AMBW-44475 ActiveMatrix BusinessWorks throws an error when mapping
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Key

AMBW-43710

AMBW-43195

AMBW-43138

AMBW-43109

AMBW-43026

AMBW-42293

AMBW-42115

AMBW-42089

Release 6.7.0

Summary
the JDBC Query activity's output to the Iterate group.

On running an application, the Activity output data
validation error is displayed when the JDBC Query activity is
used with the Iterate group.

The system:validate command throws an error and returns
incorrect status code for some projects.

TIBCO Business Studio for BusinessWorks becomes
unresponsive intermittently when you import a shared
module through maven plug-in.

TIBCO Business Studio for BusinessWorks throws the Value
for context variable is null error at runtime for some projects.
Now a Quick Fix option is available which shows the Invalid
context variable configuration error on the Problems tab
when you import a project in TIBCO Business Studio for
BusinessWorks for the Get Context activity.

After applying the quick fix, the error is not displayed and
you get a successful response.

After renaming a process package, the Input tab of the Call
Process activity is not displayed.

The XSLT is out of sync with schema component properties error
continues to occur even after a quick fix is applied post-
migration.

The last modified date of an API in the API Explorer tab is
incorrect.

TIBCO Business Studio for BusinessWorks displays incorrect

build order of modules when the projects are imported using
the bwdesign utility.
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Key

AMBW-41298

AMBW-40453

AMBW-40436

AMBW-40295

AMBW-39820

AMBW-38966

AMBW-38787

Summary

The Iterate group for a schema element did not work when
the element belonged to a no-namespace schema.

Support for migration of the tib:evaluate function is provided
in TIBCO ActiveMatrix BusinessWorks™ 6.7.0.

TIBCO Business Studio™ for BusinessWorks™ displayed null
pointer exception when constructing the CatchAllFaultDetails
document because of the incorrect transition link from the
Scope.

Now, the following error message is displayed whenever
there is a link in the process that has the source activity set
as the group end activity.

Outgoing link from Group End activity of <group_name>
group is incorrectly configured. Please delete and recreate it
to repair or apply the quick fix.

Applying the quick fix deletes the erroneous link and
recreate the link with the correct serialization.

TIBCO Business Studio for BusinessWorks did not select sub
processes correctly in the Run Configuration and Debug
Configuration windows.

TIBCO Business Studio for BusinessWorks did not display
appropriate error for a transition from the Group End activity
to any activity inside the Group.

TIBCO Business Studio for BusinessWorks failed to generate
EAR from studio and bwdesign utility due to null pointer
exception.

TIBCO Business Studio for BusinessWorks displayed an error

in the Problems tab when a module property inside a
shared module referred a process property of type JDBC
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(Continued)

Key

AMBW-38748

AMBW-38292

AMBW-37808

AMBW-37597

AMBW-37112

AMBW-34133

Core Run Time

Summary
Connection.

Leading or trailing white spaces from alias name of SSL
server shared resource did not trim when the value type was
literal value.

Null pointer exception occurred while generating .EAR for
specified customer project.

While moving the JMS shared resources from an application
module to a shared module, TIBCO Business Studio for
BusinessWorks didn't refactor the module property path
correctly.

The Job Data view in the debugger became unresponsive
while displaying large data.

The validation message was not displayed on using the
parallel JDBC activity inside the Local Transaction group.

The Iterate group configuration error because of schema
used does not have namespace. error reported if the Iterate
group used schema without namespace.

The following issues have been fixed in this release of TIBCO ActiveMatrix BusinessWorks™.

Release 6.8.1

Key Summary
AMBW- The module shared variable fails to reset to initial value on restarting an
44222 application.
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Release 6.8.0

Key

AMBW-
44452

AMBW-
44451

AMBW-
44450

AMBW-
43980

AMBW-

43770

AMBW-
43221

Summary

When migrating the ActiveMatrix BusinessWorks application from 6.4.1 to 6.6.0,
the JobsharedVariable defined in a module is not recognized by other modules of
an application.

Two applications incorrectly refer to the same hashmap in some cases when an
AppNode starts the applications at the same time, and an activator process is
used along with custom XPath functions.

For Group mode, if the AppNodes are unresponsive for more than 31 seconds
then the process starter activity is disabled for the AppNodes which results in
AppNodes are marked as inactive by the reco..///very system.

Set the com.tibco.bx.engine.recovery failure.threshold property to a value between 31 to
180 seconds.

TIBCO ActiveMatrix BusinessWorks SharedVariable does not reset to initial value
after deployed application restart.

The module shared variable failed to reset to initial value on restarting an
application.

ActiveMatrix BusinessWorks application containing the FTL Subscriber activity
having flowlimit set along with engine threads displays the out of memory error
when the number of transactions per second are increased above 50.

The JMS Receive Message activity running on an AppNode with the Group mode
fails to start when a BWEngine resumes from the Suspended state.

The Wait and Notify activities in the group persistence mode do not work with
default values for the bw.engine.threadCount and bw.engine.db.maxConnection
properties.

Set the following new properties in the AppSpace's config.ini file:

com.tibco.bx.lockWaitNotify=true
com.tibco.bw.throttle.notify.activity=true
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Key Summary

com.tibco.bw.throttle.wait.activity=true

Use the throttle properties when default configuration is used .

The bw.engine.db.maxConnection property's value must be greater than the
bw.engine.threadcount value.

AMBW- Some of the ActiveMatrix BusinessWorks jobs are not processed intermittently
43220 when an application has Wait and Notify activities.

To avoid the deadlock scenario, TIBCO recommends to set the
com.tibco.bx.lockWaitNotify=true property and the value of bw.engine.db.maxConnection
property = twice the value of bw.engine.threadCount.

AMBW- On stopping the application, an application cannot call the delete method of the

43102 shared resource when the shared resource uses module property in one of the
fields.

AMBW- The BW.MODULE.NAME and BW.MODULE.VERSION module properties return empty

43101 values.

AMBW- The Iterate group in a subprocess generates incorrect output when two different

43099 processes call the same subprocess containing the Iterate group at the same
time.

AMBW- After new installation and setup of AppSpaces and the AppNodes, the AppNodes

42919 that have "group" settings cannot start and display the following error: Unable to

find CheckpointModelFactory: DB.

AMBW- Modifications done inside a running application in TIBCO Business Studio for
42506 BusinessWorks displays the Process not found error.

AMBW- AppNode APIs now provide complete stack trace in a thread dump.

42106

AMBW- TIBCO Business Studio for BusinessWorks throws NullPointerException while running
41286 a project with different nested subprocesses.

Release 6.7.0
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Key Summary
AMBW:- The <?xml-multiple?> tag disappeared from the output of the Parse XML activity
41486 when the Validate Output check box was selected.

Set the -Dbw.application.activity.validateOutput.treeValidation=true property as VM
argument to add the tag when validating an output XML.

AMBW- The <msgCode> tag under FaultDetails could not capture the actual msgCode value.
41289

AMBW- An application was unable to resolve a process variable on startup for the Assign
41222 activity, even though the Call Process activity in the same process could resolve

the same process variable.

AMBW- The Engine Command activity did not stop an application when an application
41218 was restarted.

AMBW- Memory leak issue was observed due to an instance of to

41207 org.eclipse.xsd.XSDSchemabDirective[] on an AppNode.

AMBW- After upgrading, the Transform XML activity took more memory and generated
41045 the Out of Memory Exception.

AMBW- An application could not be started when its status was STARTFAILED.

40793

AMBW- An application using WSDL from a shared module failed to restart and displayed
40362 the java.lang.lllegalStateException: BundleContext is no longer valid error.
AMBW- The conversation handler failed when multiple AppNodes were set up in a group
40232 persistence mode.

AMBW- Ability to evaluate transition expression as XPath 1.0 expression

40145

Set the bw.engine.use.transition.xpath.expression.lang.1.0 property to true in the
AppNode's config.ini file.

By default, the value is false.

AMBW- The performance was degraded in the Iterate Group activity.
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Key

38813

AMBW-
36149

AMBW-
33830

Summary

When an application had a persistent shared module in the group mode, the
following error occurred intermittently:

PVM-MODEL-102700.
After migration, the Repeat group used in a calling process displayed

java.sql.SQLException when the JDBC Query activity was configured with a
process in subsets used inside a subprocess.

General

This topic lists the closed issues related to General issues.

Release 6.8.1

Key

AMBW-
45819

AMBW-
45489

AMBW-
45457

AMBW-
45449

Summary

TIBCO ActiveMatrix BusinessWorks plugin for Apache Maven does not resolve the
transitive dependencies when you create an EAR using the mvn package
command.

If you provide any character in the Fill With field of the Data Format shared
resource and then use the shared resource along with the Render Data or the
Parse Data activities, ActiveMatrix BusinessWorks adds the 'O' character in the
activity output instead of the character provided by you.

Any element in output editor or RVSubscriber which is expected to receive any
kind of requested XSD data structure is not mapping received data in any

element, resulting in empty output from RVSubscriber.

The Rendezvous Subscriber activity fails to process messages that are generated
with the third-party Rendezvous publishers.
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Key

AMBW-
45414

AMBW-
44957

AMBW-
44034

Summary

Unable to map the iterator element value on transition post-migration.

The context-sensitive help for TIBCO Business Studio for BusinessWorks is not
currently available in ActiveMatrix BusinessWorks 6.8.0.

The JDBC Query activity result set adds extra space in the output for a field that is
empty in the database.

Release 6.8.0

Key

AMBW-
44449

AMBW-
44448

AMBW-
44435

AMBW-
44434

Summary

Transition condition with boolean value is not evaluated correctly against String
true.

Add the new -Dbw.xml.comparable.legacy.booleanStringEquality=true property as a VM
argument along with the -

Dbw.engine.use.transition.xpath.expression.lang.1.0=true property in TIBCO Business
Studio for BusinessWorks

Empty tag is not generated for optional-nil elements.

Now, a new Treat optional-nil elements as optional elements check box is
added on Window > Preferences > Mapper page. Select the check box and clean
the workspace.

After cleaning the workspace, you get some XSLT out-of-sync errors on the
Problems tab. Use the Quick Fix option to resolve those errors and execute the
project again to generate empty tags for the optional-nil elements.

Input and Output schemas are not formed correctly when creating a Mesh client
for a ActiveMatrix BusinessWorks and TIBCO Flogo Open API Specification 3.0
Mesh Service.

After Tibtunnel recovers from its termination, ActiveMatrix BusinessWorks cannot

connect to the on-premise resources such as Enterprise Message Service (EMS) for
one round of Timer trigger.
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Key Summary

AMBW- ActiveMatrix BusinessWorks consumes a large memory heap and throws the out
44350 of memory error when you read a file using the Java Invoke activity.

AMBW- If you select the Generate Implementation Specification check box, the REST
44305 service binding binds properly with the newly generated Swagger specification

and the same specification appears in the Manifest.json while exporting the
application EAR.

AMBW- ActiveMatrix BusinessWorks does not display expected elements, if any, when an

44090 unexpected element is encountered while validating an XML document against a
schema.

AMBW- Oracle JDK 11.0.12 is now bundled with this release of ActiveMatrix

43867 BusinessWorks.

AMBW- When an XSLT transformation fails, the stack trace does not show the element

43209 that fails during the transformation and the cause of the failure on the Render

JSON activity.

AMBW- The Write File activity cannot generate a file when the TextContent field has the
43104 space character (" ") value.

AMBW- The literal white space character (") is not datatype-valid with respect to the datatype definition '
43100 {http://mvww.w3.0rg/2001/XMLSchema}double'. error is displayed in mapper.

To avoid typecasting error, use the following VM argument:

-Dbw.xml.general-comparison.ignore-numeric-cast=true

AMBW- An application throws an error when an activity's XPath contains the insert-before()
43098 function.

AMBW- The whitespace characters (' ') are trimmed in a string field of the Mapper

43097 activity.

AMBW- The bwdesign utility shows the NLS unused message warning when exporting a
43044 project.
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Key

AMBW-
42903

AMBW-
42657

AMBW-
42568

AMBW-

41646

AMBW-
34798

AMBW-
33760

AMBW-
33562

Summary

A SOAP service having the Reply activity throws the following error for an error
configured on the Reply activity when the Reply activity has an input value
mapped to the Description field:

$$$$$ ERROR occurred while converting between Axiom and BW preferred node type.

You cannot add the duplicate When condition along with its expression if you use
the Surround with Choice option for an element, and then try to duplicate the
When condition.

An application throws an error on design time and runtime when an activity's
XPath contains the min() and max() function. A new Quick Fix option is provided
to resolve the error.

Smart Mapper cannot create a For Each statement for a repeating element.
The $ParseXml/primitive>sum($ParseXml/NewElement) expression generates incorrect

results with XPath 2.0 when the following VM arguments are set in TIBCO Business

Studio for BusinessWorks: -Dbw.application.activity.validatelnput=false and -
Dbw.application.activity.validateOutput=false

Transition expression is not saved in MAC OS.

TIBCO Business Studio for BusinessWorks does not show the job data when
debugging an application in the debugger

Release 6.7.0

Key

AMBW-
41613

Description

The activity input data validation error occurred when converting a double value
to a decimal value and the -Dbw.application.activity.validateOutput=false property was
set in the config.ini file.

A new -Dbw.xml.decimal.allowDoubleExponent property is added.
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Key

AMBW-
41486

AMBW-
41289

AMBW-
41223

AMBW-
41222
AMBW-

41221

AMBW-
41218

AMBW-
41207

AMBW-
41045

AMBW-

40860

AMBW-
40793

Description

Set the -Dbw.xml.decimal.allowDoubleExponent property to true along with the -
Dbw.application.activity.validateOutput=false in the config.ini file.

The <?xml-multiple?> tag disappeared from the output of the Parse XML activity
when the Validate Output check box was selected.

Set the -Dbw.application.activity.validateOutput.treeValidation=true property as VM
argument to add the tag when validating an output XML.

The <msgCode> tag under FaultDetails could not capture the actual msgCode value.
The trim() mapper function in the Group by clause failed and generated the XSLT
transformation error at run time.

An application was unable to resolve a process variable on startup for the Assign
activity, even though the Call Process activity in the same process could resolve

the same process variable.

The input tab mappings were not visible for activities when the if condition in the
XPath function was empty.

The Engine Command activity did not stop an application when an application
was restarted.

Memory leak issue was observed due to an instance of to
org.eclipse.xsd.XSDSchemaDirective[] on an AppNode.

After upgrading, the Transform XML activity took more memory and generated
the Out of Memory Exception.

The coercion failed to fetch the correct elements for mapping and displayed a
validation error at design time when there were two elements of the same name

and namespaces, but from the different schemas.

An application could not be started when its status was STARTFAILED.
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Key

AMBW-
40362

AMBW-
40232

AMBW-
40145

AMBW-
39898

AMBW-
39494
AMBW-

38971

AMBW-
38813

AMBW-
36149

AMBW-
36034

AMBW-
33830

Description

An application using WSDL from a shared module failed to restart and displayed
the java.lang.lllegalStateException: BundleContext is no longer valid error.

The conversation handler failed when multiple AppNodes were set up in a group
persistence mode.

Ability to evaluate transition expression as XPath 1.0 expression

Set the bw.engine.use.transition.xpath.expression.lang.1.0 property to true in the
AppNode's config.ini file.

By default, the value is false.

The XSD resolver could not process the id attribute in the xs:group element.
Summary: The current-dateTime() function returned different representation of
output in TIBCO Cloud Integration, ActiveMatrix BusinessWorks, and TIBCO

ActiveMatrix BusinessWorks Container Edition.

After migration, coercion disappeared and had to be remapped frequently.

The performance was degraded in the Iterate Group activity.

When an application had a persistent shared module in the group mode, the
following error occurred intermittently:

PVM-MODEL-102700.
An application was not visible in the Debug Configuration window when the

project's name was different than the value of the ID field of the Overview section
of the project.

After migration, the Repeat group used in a calling process displayed

java.sql.SQLException when the JDBC Query activity was configured with a
process in subsets used inside a subprocess.
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Migration

This topic lists the closed issues related to Migration.

Release 6.8.1

Key

AMBW-
44538

Description

After migration, the element inside the Catch all > error_variables are not
resolved correctly when a process with more than one fault element is configured
in the End activity.

Release 6.8.0

Key

AMBW-
43791

AMBW-
43501

AMBW-
42280

AMBW-
41353

Description

After migration, the mapper input is empty when the schema is referenced from
data format shared resource.

The migration tool migrates processes with the REST-Dispatch-and-Reply activity
to a REST resource. In TIBCO ActiveMatrix BusinessWorks™ 5.x, the service
processing logic is delegated to a subprocess as per operation. Normally the
subprocess is migrated. To supplement this, a call process is created to invoke
that subprocess in the REST resource.

You may need to fix the mapping for the newly created call process manually.
This could fix the mapping itself, or the input and output schemas for the called
subprocess.

Note: The REST Service descriptor supports both internal and external WADL
references. However, we do not support multiple resources pointing to the
same resource path and having the same HTTP method.

After migration, the Mapper activity is migrated as an empty activity.

After migration, if the variable list XPath expression of an Iterate group is linked to
multiple schemas then the iterator schema is not resolved.

TIBCO ActiveMatrix BusinessWorks™ Release Notes



49| Closed Issues

Key Description
AMBW- Getting "Coercion error: Can't find substitution for ™." at design time after migrating a
33641 project.

Release 6.7.0

Key Description

AMBW- After migration, the $error_<activityname> was not migrated and failed to fetch error
41319 details from the Local Transaction group.

AMBW- After migration, the subprocess containing the padfront() function failed at runtime.
41022

AMBW- After migration, multiple errors occurred for DTD to XSD conversion.

40178

AMBW- After migration, the SOAP Request Reply activity could not migrate successfully.
40068

AMBW- After migration, transitions to Invoke activities were not present in a process.
40067

AMBW- After migration, the faultDetails mapping was incorrect.

38737

AMBW- After migration from the SAP adapter configurations to TIBCO ActiveMatrix

37700 BusinessWorks™ Plug-in for SAP, the mappings were not migrated.

AMBW- After migration, the pipe character ('|") was converted to the "or" condition which
37114 resulted in incorrect activity output.

AMBW- The transition condition now has the migration support of adding the XPath 1.0
31022 tag.
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Palette

This topic lists the Closed Issues related to Palettes.

Release 6.8.1

HTTP Palette

Key Summary
AMBW- For the applications using the HTTP Client shared resource configured with the
45532 Thread Pool shared resource having Core Pool Size greater than 10,

"lllegalArgumentException" is thrown at runtime.
AMBW- ActiveMatrix BusinessWorks redirects a SOAP call to the HTTP Receiver activity if

45450 the Enable Access Log property is enabled and an application contains both a
SOAP service and HTTP Receiver activity.

JDBC Palette

Key Summary

AMBW- You can see the Updated Parameter->Data type value in the JDBC statement
44571 parameter preparation.

AMBW- Interpreted the Invalid XML Chars check box, not available in ActiveMatrix
45455 BusinessWorks 6.6.1. You can see an Invalid white space character (0x1c) in the

text to output.

AMBW- The Number element on the Input tab of JDBC Call Procedure activity shows an
45445 integer value and not a decimal value after loading the procedure or function.
AMBW- ActiveMatrix BusinessWorks does not retrieve data of type timestamp from a
43303 database.
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JMS Palette

Key Summary
AMBW- If we use a JNDI Destination name for the actual queue in the ActiveMatrix
45456 BusinessWorks project when connecting to the IBM MQ server, it gives

InvalidDestinationException.

AMBW- Huge memory consumption is causing the AppNode to hang. A new session is

45454 being created on every run causing huge memory consumption. Now, the Ack
Mode in the key is used also while pulling which resolves the huge memory
consumption issue as the session is not created on every run.

AMBW- The null pointer exceptions are thrown when you destroy the JMS Reply activities
45333 while application instances are being stopped.

AMBW- The JMS Request Reply activity in ActiveMatrix BusinessWorks 6.x creates a new
44019 Message Producer per request, which causes the disk overhead on the EMS side,

hence leading to performance issues.

AMBW- When you use an element from some external schema to join the conversation,
43126 the mapping showed an error "No matching namespace prefix".

AMBW- There is no option available for "Supports XA Transactions" in JMS Connection in
35465 ActiveMatrix BusinessWorks 6.x.x.

AMBW- Get JMS Queue Message activity shows different types of timeout errors for the
31953 same scenario when there is no message in the queue.

Mail Palette

Key Summary
AMBW- "Test connection" for SMTP resource shows the error "Configuration error in field
45461 [Host] and/or [Port], the value must be a valid hostname and/or port" with

correct values.
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Java Palette

Key Summary
AMBW- The SOAP Invoke MTOM throws a Java heap space out of memory error with large
44678 payloads of 800 MB.

Parse Palette
Key Summary
AMBW- You cannot rename a file when you use the Parse Data activity to read the file in
45862 batches.

Release 6.8.0

HTTP Palette

Key Summary
AMBW- The Send HTTP Request activity fails and throws TimeoutException when the HTTP
43969 Client shared resource is configured with the Jetty HTTP Client library along with

SSL, and the Proxy shared Resource without authentication.
AMBW- The Send HTTP Request activity fails with 500 error when the HTTP Client
43072 shared resource configured with Apache HTTP Components library and a request

with MIME attachment is sent to REST service.

AMBW- ActiveMatrix BusinessWorks can not handle non-preemptive basic authentication
42083 when the User-Agent header is not present in the HTTP request.
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Key

AMBW-
43984

AMBW-
43983

AMBW-
43965

AMBW-
43964
AMBW-

43037

AMBW-
42443

AMBW-
42049
AMBW-

41912

AMBW-
38321

AMBW-
31970

JDBC Palette
Summary

An application goes into the Impaired state when the dbURL has special
characters.

The JDBC Call Procedure activity throws an error and cannot call a stored
procedure when you use PostgreSQL 12 database.

The JDBC Query activity throws the Numeric overflow error when the number
coming from the database is greater than 10 digits.

TIBCO Business Studio for BusinessWorks displays timeout error with SQL stored
procedures when you use Data Direct Driver and XML type parameters as IN or
OUT.

The SQL Direct activity fails for Unicode special characters.

TIBCO Business Studio for BusinessWorks now supports overloaded procedures
from PostgreSQL.

The stored procedure input and output parameters with MSSQL DataDirect driver
are inaccessable if the procedure is selected without selecting Schema, and

Catalog or Package.

Heap memory leak is observed on an AppNode for the SQL Direct activity in an
application,

The JDBC Tibco Driver for PostgresSQL is upgraded from 5.1.4.000097 to
5.1.4.000329 and the Native Driver is updated with 9.4.1212 to 42.2.18.

JDBC Driver for Microsoft SQL server is upgraded from 4.0 to 8.2.2.
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JMS Palette

Key Summary
AMBW- Whenever EMS fault-tolerance server is switched or the EMS server is restarted,
43981 the JMS Send Message activity loses the first message after reconnecting.
AMBW- Exchange of message takes place for a queue type messaging style configured in
42608 JMS Sender and a topic type messaging style in JMS Receiver.
AMBW- TIBCO Business Studio for BusinessWorks displays an error when connecting to an
37702 SSL enabled EMS server.
Mail Palette

Key Summary
AMBW- An application becomes unresponsive on the Send Mail activity and does not
43990 timeout when the existing engine threads are occupied.

REST and JSON Palette
Key Summary
AMBW- The Invoke REST API activity is migrated as empty for some activities.
43585
AMBW:- The design time and run time Swagger files are now including the definitions of
43255 the extended elements from different XSD.
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Key

AMBW-
44572

AMBW-
43994

AMBW-
41240

AMBW-
33245

XML Palette
Summary

Non-default namespace can not map to empty URI Set the -Dbw.xml.jsonrest.multiple-
ns.removensprefix=true property as a VM argument in TIBCO Business Studio for
BusinessWorks.

This property removes all non default prefixes from the XML and uses only default
namespace prefix for all namespaces and ensures that a non default namespace
is never bound to an empty URI.The Render XML activity adds an extra
namespace xmlns="" at the root level of the schema.

The Value-of max(xsd:int*) expression returned as a scientific notation value when
the Transform XML activity has bigger numbers in input.

The Parse XML activity gives error when the input file encoding was UTF-8-BOM
and the Validate Output check box was selected.

Set the -Dbw.application.activity.validateOutput.treeValidation=true property as a VM
argument when validating an output XML.

An error occurs when the YearMonth datatype is typecasted with the xsd:string().

Release 6.7.0

Key

AMBW-
38106

FTP Palette
Summary
The FTP Rename File activity failed intermittently to rename files from a
particular directory when the FTP Rename File activity was a part of a

subprocess, which was called from a Call Process activity with the Spawn check
box selected.
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Key

AMBW-
41408

AMBW-
41006

AMBW-
40484

Key

AMBW-
42049

AMBW-
41608

AMBW-

HTTP Palette
Summary

The Send HTTP Request activity threw the HttpClientException when the
application deployed on TEA was restarted, and the HTTP Client shared resource
had the Apache HttpComponents(Supported by HTTP 1, SOAP and REST)
implementation library, and the Provide Client Resource check box was selected
on the Advanced tab of the Send HTTP Request activity.

The SSL was configured even when the SSL Client shared resource picker was not
empty and the module property against the Confidentiality field at HTTP Client
shared resource was set to false.

Set the bw.plugin.http.client.relyOnConfidentialityField property to true.
The Send HTTP Request activity could not send the request with Content-type as
multipart/form-data to ServiceNow with Apache HttpComponents library.

Send the request using the Jetty HTTP Client library in the HTTP Client shared
resource.

JDBC Palette
Summary
The stored procedure input and output parameters with MSSQL DataDirect driver
were inaccessable if the procedure was selected without selecting Schema, and

Catalog or Package.

The JDBC connection created against the database increased beyond the
configured value when any of the following cases occurred:
e There was a network issue.

¢ Database was stopped or started

* The bw.engine.activity.async.waitTime property was present in the config.ini file.

The Null Pointer Exception was thrown when re-connecting the database with an
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Key

41215

AMBW-
41146

AMBW-
41145

AMBW-
40335

Key

AMBW-
41548

AMBW-
40637

AMBW-
35597

AMBW-
34959

JDBC Palette
Summary
application.

The input and output parameters for a stored procedure were not accessible
when the stored procedure was inside a package.

The JDBC Call Procedure activity failed and generated the Unknown exception
occurred.

TIBCO ActiveMatrix BusinessWorks™ generated the java.sql.SQLException at
runtime when the Database URL had forward slashes in the sslTrustStoreLocation
path.

JMS Palette
Summary

For the ActiveMQ JMS provider, the JMS Receive Message activity failed to
reconnect for network issues.

The JMS Send Message activity displayed the Null pointer exception
intermittently when messages were sent in concurrent batches.

The JMS Request Reply activity can now filter requests and response messages
correctly on the basis of JMS CorrelationlD or MessagelD.

Messages were stuck in an EMS queue when the EMS connection dropped and
reconnected.

This issue occurred intermittently when the AppSpace was configured with
FTgroup persistence with the EMS FT URL.

Also, the secondary EMS server was not available intermittently after the failure of
the first server.
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Key

AMBW-
33187

Key

AMBW-
39777

AMBW-
39776

Key

AMBW-
41167

AMBW-
40875

AMBW-
40618

JMS Palette
Summary
In TIBCO Business Studio™ for BusinessWorks™, the default value for the

Directory preference option on the BusinessWorks > Palettes > JMS preference
page was invalid.

Mail Palette

Summary
The Receive Mail activity used to start the handshake with TLSv1 irrespective of
the TLS SSL Protocol selected in the SSL Client Configuration for the SMTP
shared resource.
The Send Mail activity used to start the handshake with TLSv1 irrespective of the
TLS SSL Protocol selected in the SSL Client Configuration for the SMTP shared
resource.

REST and JSON Palette
Summary
For some scenarios, the Parse JSON activity generated the XMLStreamException

in the console, in logs and the Output tab in Job Data view became empty when
an application was executed in the debug configuration.

Set the bw.engine.debug.core.disableNamespaceFixup property to true.

Do not use this property while mocking the output for unit testing.

The Parse JSON activity could not parse a JSON key having a value of array type
with length more than 512 characters.

Logs for the Invoke REST API activity now also display the response body
information. Set the following logger in the logback.xmil file:
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Key

Key

AMBW-
41240

AMBW-
33245

REST and JSON Palette

Summary

<logger name="com.tibco.bw.palette.restjson.runtime.RestInvoke">
<level value="DEBUG"/>
</logger>

XML Palette
Summary

The Parse XML activity threw Content is not allowed in prolog error when the
input file encoding was UTF-8-BOM and the Validate Output check box was
selected.

Set the -Dbw.application.activity.validateOutput.treeValidation=true property as a VM
argument when validating an output XML.

An error occurred when the YearMonth datatype was typecasted with the xsd:string

0-

Policies

This topic lists the Closed Issues related to Policies.

Release 6.6.1

Key

AMBW-
39090

AMBW-
38857

Description

A SAML message was not forwarded and generated the following error:

Error unmarshalling a SAML assertion.

The Heap Out of Memory message was thrown for faulted jobs while using the
SOAP/HTTP Invoke activity with Policy Basic Authentication.
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Key Description
AMBW- The performance was degraded when the authentication was done with LDAP.
37873
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Known Issues

The following known issues have been identified in this release of TIBCO ActiveMatrix
BusinessWorks™.

The known issues are grouped by components:

e Administration

e Binding

e General

e Migration

o Palette

e Policy

Administration

This topic lists the Known Issues related to Administration.

Key

AMBW-
46059

AMBW-
44868

AMBW-
44826

Description
Summary: The application properties are not displayed in the Internet Explorer
browser.

Workaround: Use any other web browser such as Google Chrome, Firefox, or
Microsoft Edge.

Summary: The bwadmin --help command still shows help for the upgrade
command that is not supported in this release.

Workaround: None

Summary: When OpenTelemetry is enabled or disabled via Admin Ul or Admin
CLl, in pertaining debug level log, EnableOpenTracingCommand or
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Key Description

DisableOpenTracingCommand is displayed respectively.

Workaround: None

AMBW- Summary: If an AppNode log is not present and you click the Download Log
41955 button from Admin Ul, an exception is thrown.

Workaround: Start an AppNode and try again

AMBW- Summary: When agent is started with MySQL 8.x jar, a harmless message about
41795 the driver being deprecated is displayed on bwagent and the bwadmin console.

Workaround: None

AMBW- Summary: A harmless warning is shown when starting a BWAgent.
41794
Workaround: None
AMBW- Summary: The Appnodeconfig button is not available under the Appnode Data
41555 view.

Workaround: Navigate to any other page within an AppNode and then navigate
to appnode config.

AMBW- Summary: Harmless logs are shown at Admin Console on SUSE 12 Linux.
37468
Workaround: None
AMBW- Summary: Process monitoring statistics are not populated if checkpoint has been
32929 used in the process.

Workaround: None

AMBW- Summary: On Process Monitoring page, Job filter displays results for records on
32922 the current page only.

Workaround: None

AMBW- Summary: Sometimes all the transitions are not highlighted and input/output
32904 data is not seen for activities when process monitoring is enabled using UDP
transport.
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Key

AMBW-
32594

AMBW-
32071

AMBW-
32057

AMBW-
31832

AMBW-
31831

AMBW-
31600

AMBW-
31493

AMBW-
30759

AMBW-

Description
Workaround: Use FTL transport for process monitoring.

Summary: On the Process Monitoring page, the Datetime value in the
MM/DD/YYYY format for filtering jobs does not work.

Workaround: Use the datetime value as displayed in the database

Summary: Failed to Upload Large EAR file larger than 10MB with MariaDB.

Workaround: Use any other database.

Summary: Agent Count is getting increased for AppSpace after restoring Domain.

Workaround: None

Summary: In the process diagram view of Process Monitoring, if a constructor
block includes a catch block, then it is not highlighted after its execution.

Workaround: None

Summary: In Process Monitoring, sometimes, because of uid issue references are
not highlighted and input or output data might not displayed.

Workaround: Remove all uid related warnings from TIBCO Business Studio™ for
BusinessWorks™. Create an EAR file. Deploy the EAR file, and then enable process
monitoring.

Summary: When an application is running and AppNode is restarted, the job id is
duplicated and two jobs with same id is present under process monitoring.

Workaround: None

Summary: User is getting considered as Role in file based authorization.

Workaround: None

Summary: Failed to get AppNode Config.ini file's property details by REST API.

Workaround: None

Summary: Unable to register BWAgent from the command line on some

TIBCO ActiveMatrix BusinessWorks™ Release Notes



64 | Known Issues

Key

30398

AMBW-
29846

AMBW-
29725

AMBW-

29632

AMBW-
29235

AMBW-
28244

AMBW-
27654

Description

machines.

Workaround: None

Summary: Process diagrams are not visible on the Admin Ul when the project
name has a period (.) between the numbers.

Workaround: Remove the number from the process package name, regenerate
the EAR file, and re-deploy it.

Summary: The Internal Server Error is displayed intermittently in logs when there
is a change in the network.

Workaround: None

Summary: Process diagram is not shown in TIBCO® Enterprise Administrator

when the TIBCO ActiveMatrix BusinessWorks™ process package name contains
number.

For example com.tibco.bw.service.SIXXXZZZ.1.0
Workaround: None
Summary: When application components are started or stopped multiple times

from the Admin Ul, the TIBCO-BW-TEAAGENT-500506: Failed to get components
for Application error is sometimes displayed.

Workaround: Refresh the entire page or navigate to different tab, for example,
the AppNodes or AppSpaces page and then go back to the Components tab.
Summary: Admin Ul shows wrong information under Installation tab after

upgrade.

Workaround: None.

Summary: Identity-Truststore is not created for the SSL Client post migration.

Workaround: After migrating the SSL enabled service , it will create the SSL client
resource. In SSL client resource, provide the keystore provider resource in
Keystore Provider as Trust Store. Provide the Keystore only. This will import all
the certificates required for SSL enabled services in ActiveMatrix BusinessWorks™
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Key Description

6xX.
AMBW- Summary: Unable to upload large sized EAR files (~10 MB) when the DB2
26286 database is used for the DBEMS or DBFTL mode.

Workaround: None

AMBW- Summary: From the command line, users can enable the OSGi and create a new
25889 AppNode on the same OSGi port.

Workaround: Use the Admin Ul to enable the OSGi port.

Binding

This topic lists the Known Issues related to Binding.

Key Description

AMBW- Summary: The "allOf" tag is not reflected in the runtime Swagger JSON

46002 generated for the REST service created using an imported Swagger JSON having
the "allOf" tag.

Note: The schemas are merged into a single schema object in the runtime
Swagger file and this doesn't impact the functionality.

Workaround: None.

AMBW- Summary: The Swagger specifications having the pattern keyword are not
45941 supported in ActiveMatrix BusinessWorks 6.x.

Workaround: You can either manually modify the Swagger specifications to
remove the pattern tag before importing it in TIBCO Business Studio for
BusinessWorks, or else after creating the service, you can manually modify the
XSD by removing the pattern restriction for the respective element definition.

AMBW- Summary: The deescription provided for form parameters on REST 3.0 service
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Key Description
44739 binding is not reflected on the reference binding as well as on top-down service
binding's Form Parameters table.

Workaround: None

AMBW- Summary: The 415: Unsupported Media Type error is thrown on Invoke activity of a
44492 REST Reference Binding while invoking a REST service with Request and Response
formats other than JSON. That is, XML or Text.

Workaround : To get rid of the error, select JSON format in Request and
Response along-with other formats.

AMBW- Summary: The dynamicConfigurations WSDL part and dynamicConfigurations
44479 element aren't automapped by default for the input of Invoke activity created
from the reference binding.

Workaround: Either map manually or map using the Show Check and Repair

option.
AMBW- Summary: On selecting Binary checkbox in Response tab of REST Service Binding,
44338 if we keep default configurations in Resource Schema then the Reply activity's

response is seen as "String" instead of base64Binary.

Workaround: On selecting Binary checkbox re-select "binary" or "base64" from
Resource Schema dropdown.

AMBW- Summary: The java.lang.NullPointerException is thrown on adding new operation to a
44208 REST service when you change the JSON Definition Style or the Request schema
from the drop-down for the newly added operation.

Workaround: If you are adding new operation then select the required schemas
in the REST Service Wizard and avoid modifying it from service binding.

AMBW- Summary: REST Service Binding configuration error is thrown at design time when the
44197 Resource Schema of DELETE operation is modified in the Response tab of REST
Service Binding.

Workaround: If you want the DELETE operation response to be other than String
then select the appropriate value in the drop-down menu for Response while
creating a service using REST Service Wizard.

TIBCO ActiveMatrix BusinessWorks™ Release Notes



67 | Known Issues

Key Description
This workaround is not applicable for the Binary Response format.

AMBW- Summary: For REST 3.0 service if you select Binary check box in Response, then

44116 at design time the Resource Schema details "Sitem base64Binary" is not
displayed on Response tab for all operations on service binding and for POST
operation on reference binding. There is no impact on anything at runtime.

Workaround: None.

AMBW- Summary: The Swagger Ul accessed using Lrestdoc command is not supported to

44022 show the callbacks section for the REST Operation of an ActiveMatrix
BusinessWorks REST Service Endpoint created by dragging a Swagger Path whose
operation is configured with callbacks.

Workaround: None.

AMBW- Summary: The Swagger Ul is seen as blank when the Swagger URL is hit from
43156 Internal Web Browser in TIBCO Business Studio for BusinessWorks.

Workaround: Hit the Swagger URL from an external browser.

AMBW- Summary: The "format" tag is not created for "Password" type form parameter in
43023 bottom-up REST service and hence seen as String on the reference binding.

Workaround: Manually add the "format" : "password" tag to the form parameter
in the swagger file.

AMBW- Summary: A multipart message where one part points to type and the other part
36113 points to element and a message using mixed security mode is not supported.

Workaround: Change mixed security mode in a given WSDL.

AMBW- Summary: A SOAP service responding with mustUnderstand attribute as true is

32951 ignored irrespective of selecting or deselecting the Ignore mustUnderstand
check box on the SOAP Reference binding. This behavior does not affect the client
and server communication.

Workaround: None

AMBW- Summary: On creating SOAP Reference Binding with the concrete WSDL

TIBCO ActiveMatrix BusinessWorks™ Release Notes



68 | Known Issues

Key Description

32760 generated at run time with multilevel schema imports, the
java.lang.NullPointerException is displayed when clicking the reference binding.

Workaround: None

AMBW- Summary: When creating a concrete WSDL by right-clicking on the Service
29098 Descriptor folder, the following error is generated at design time: WSDL import
error.

Workaround: None

AMBW- Summary: On importing WSDL with RPC Encoded style, a validation error is
27870 generated at design time since the underlying schema with namespace
http://schemas.xmlsoap.org/soap/encoding/ is not generated.

Workaround: To remove the validation error and create the SOAP Reference
Binding, download the encoding schema with the said namespace and ensure
that schema is a part of the application module or the shared module.

AMBW- Summary: When module properties used from a shared module project were
27435 renamed, the changes made were not reflected at the SOAP binding level.

Workaround: Select the updated module property from the drop down in the

SOAP binding.
AMBW- Summary: When a REST service with a schema that uses a type which was
26806 imported from another XSD is invoked in a REST Reference Binding, it fails with

the ServiceRuntimeException.

Workaround: None

AMBW- Summary: When the WSDL uses multiple parts in the Request body of an
23104 operation, a design time validation error occurs on the generated SOAP reference
binding. The application works fine at run time.

Workaround: None
AMBW- Summary: When the REST Service which is implemented with GET Operation with

22981 Response as String, then the content-type of the response is changed from
application/json to text/plain.
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Key Description
Workaround: Use XSD Element in Response instead of String.

AMBW- Summary: REST Call failed on run-time under non-UTF8 locale environment.

21363
Workaround: Set the default encoding of the AppNode to UTF-8 by adding "-

Dfile.encoding=UTF-8" to java.extended.properties of "bw/6.3/config/bwappnode-
an. tra_template".

AMBW- Summary: REST Doc Ul is not supported on Firefox browser.
13607
Workaround: Use other browsers for the Doc Ul.
AMBW- Summary: For some use cases, REST Doc Ul does not show the correct error code
13572 in case of Internal Server errors on the Server side.

Workaround: Check the raw message that contains the correct error code.

AMBW- Summary: REST Doc Ul does not support browsers like Internet Explorer.
13485
Workaround: Use Chrome browsers for the Doc Ul.
AMBW- Summary: Changing the Resource name in the REST service Bindings tab, does
8982 not update the Resource Service Path.

Workaround: None

General

This topic lists the Known Issues related to General issues.

Key Description

AMBW- Summary: The OSGi commands to start and stop the application do not work.

46056
Workaround: Use TEA, Admin CLI, or REST API to start and stop the application.

AMBW- Summary: The Ant task failure error occurs when you uninstall ActiveMatrix
45408 BusinessWorks 6.8.0 hotfixes, 6.8.0, and 6.7.0 from the TIBCO_HOME containing the
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Key Description

version 6.7.0.

Workaround: Ignore the errors and proceed further with uninstallation.
AMBW- Summary: A non-readable POM file error is thrown upon importing CXF project
45183 from Maven repository.

Workaround: None. It does not affect the functionality.
AMBW- Summary: The FluentD container fails to insert the activity (input/output) data if
45146 the data size is greater than 4000 characters for the Oracle database.

Workaround: Set the MAX_STRING_SIZE = EXTENDED for the Oracle database,
which increases the byte size capacity from 4000(default) to 32767. Note that this
change is at the server level and is irreversible.

AMBW- Summary: An activity having a large input data is not shown in the job details on
45015 the Execution History tab for MySQL.

Workaround: None

AMBW- Summary: On some Linux machines, you cannot launch TIBCO Business Studio for
44769 BusinessWorks.

Workaround: You must ensure that you have GTK 3.2 installed on your machine
and then re-launch TIBCO Business Studio for BusinessWorks.

AMBW- Summary: The Transform XML activity's output is not visible in Job Data
44643 debugger output tab.

Workaround: This issue occurs only on Windows operating system. So a mouse
click and mouse hover on the Job Data section during debugging the application
on the Transform XML activity displays the output.

AMBW- Summary: Two .application folders are created when a new application is created in
44437 a new workspace.

Workaround: On launching TIBCO Business Studio for BusinessWorks wait for 5-10
seconds to ensure that it loads completely and then create a new application. If
there are two .application folders created after loading TIBCO Business Studio for
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BusinessWorks then restart it.

AMBW- Summary: EMF Validation does not work for imported existing projects by using
43862 Module Property to Keystore URL.

Workaround: Reassigning the same module property resolves the validation error.

AMBW- Summary: Consuming a TIBCO Flogo service with parameters having Object data
43860 type in Input and Output schema from ActiveMatrix BusinessWorks client is not
supported.

Workaround: None

AMBW- Summary: Unit testing does not start when a connection is not successful for the
43779 HTTP Receiver being mocked.

Workaround: None

AMBW- Summary: In some scenarios, unit testing does not work for Java palette activities.
43743

Workaround: None.

AMBW- Summary: For Open API Specification 3.0 service, the array of Form Parameters is
43118 sent as comma-separated values from Swagger Ul which causes the request to fail
with the 500 internal server error in TCI.

Workaround: Use Runtime swagger file to create the service.

AMBW- Summary: You can't launch TIBCO Business Studio for BusinessWorks after adding
42385 it into Dock in MAC OS.

Workaround: None.

AMBW- Summary: Customization of template for an unencrypted project template fails.

42174
Workaround: Import the template directly in TIBCO Business Studio for

BusinessWorks and rename it as per your requirement.

AMBW- Summary: Encryption Setting Window shows no editable fields when opened by
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42046 clicking on the Lock Icon if TIBCO Business Studio™ for BusinessWorks™ is not in
full-screen mode.

Workaround: Open Encryption Settings when TIBCO Business Studio for
BusinessWorks is in full-screen mode or enter into full-screen mode for Encryption
setting if it is opened in a minimized view.

AMBW- Summary: Eclipse command line options such as -clean does not work with TIBCO_
41991 HOME/studio/4.0/eclipse/TIBCOBusinessStudio.app/Contents/MacOS/TIBCOBusines
sStudio executable on macOS platform.

Workaround: Use the following command:

TIBCO_HOME/studio/4.0/eclipse/Eclipse.app/Contents/MacOS/TIBCOBusinessStudio --
launcher.ini TIBCO_HOME/studio/4.0/eclipse/TIBCOBusinessStudio.ini -clean or any other
eclipse command line option

AMBW- Summary: In bwdesign, if we export substvar files with the same name twice in the
41950 same location, it does not overwrite the substvar file.

Workaround: Delete the previous substvar file and export substvar again.

AMBW- Summary: Many to one mapping is not supported for Smart Mapper.

41948
Workaround: None

AMBW- Summary: Any operation on the module or application properties that leads to a
41846 change in their order results in a faulty difference generation. So, such operations
are not supported in TIBCO ActiveMatrix BusinessWorks™ 6.7.0.

Workaround: None.

AMBW- Summary: The lock icon on the encrypted profile in the difference viewer

41832 perspective is shown based on whether the workspace copy of the profile is
encrypted or not. Currently, if the workspace copy of the profile is encrypted, then
in the difference viewer perspective, the lock icon is shown even on the un-
encrypted revisions of that profile.

Workaround: None.

TIBCO ActiveMatrix BusinessWorks™ Release Notes



73 | Known Issues

Key Description
AMBW- Summary: The properties and profile are not showing in the application property
41827 editor on opening the editor for the first time in a new workspace.

Workaround: Close and reopen the editor, it shows all the details.

AMBW- Summary: If a keystore file location or name is changed then on refresh blank
41779 property value is shown and on running the application, the File Not Found
Exception is thrown.

Workaround: Restore file with a valid name at a specified location on disk and do
project clean.

AMBW- Summary: Any changes in the module or application properties inside groups are
41716 not supported in ActiveMatrix BusinessWorks 6.7.0 and the corresponding
difference generation is faulty in such cases.

Workaround: None.

AMBW:- Summary: The difference viewer calculates the difference and highlights the
41715 properties, but does not highlight any corresponding fields of the properties.

Workaround: Switch to the text difference mode and see the difference in the non-

Ul fields.
AMBW- Summary: In the substitution variables file, only five types of module properties
41499 are saved: String, Integer, Long, Boolean, and Password.

When a module property is assigned a type other than the above-mentioned types
then that type is saved as a String in the substvar file in the Diff Viewer window.

Workaround: None.

AMBW- Summary: If there are any changes in the Description field of a module or
41474 application property, it is not highlighted in the difference viewer.

Workaround: None.

AMBW- Summary: Multiple coercion does not work upon trying to toggle the faulty
41417 process.
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Workaround: The QName conflict here refers to having two schemas defining two
elements with exact same name and same namespace, but the element contents
differ. This causes design-time problems without warning when you use both
elements in the same process.

AMBW- Summary: Application property editor does not display value in case of removing
41307 encryption setting using the Clear All button and exporting profile.

Workaround: Close the application properties editor and open it again.

AMBW:- Summary: When you try to install a missing plugin using the Quick Fix option and

41277 you select or unselect a plugin version from the list of provided versions; the
following message is displayed: Cannot complete the install because of a
conflicting dependency.

However, you can still install the plugin successfully.

Workaround: None.

AMBW- Summary: The application property editor doesn't get refreshed intermediately on
41271 encrypting profiles.

Workaround: None.

AMBW- Summary: The New Name field in the Rename Projects section on the Create
41252 Project From Template window is not enabled on a single click.

Workaround: First click on the old name of the module or the application after
which the field is enabled. .

AMBW- Summary: The Password field is shown as changed while doing a Shared Resource
41155 diff, even if the password are the same.

Workaround: None.

AMBW- Summary: Confirmation message is displayed with any operation on encrypted
41238 profiles.

Workaround: Click Yes.
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AMBW- Summary: The Authentication field is shown while doing a diff when the
41035 Confidentiality field is set for HTTP Connector shared resource.

Workaround: None.

AMBW- Summary: Default icon shown instead of Custom icon for the Call Process and
40811 Java Invoke activities within external shared module.

Workaround: Manually browse the Custom icon field value and add respective icon
to activity on importing external shared module.

AMBW- Summary:ActiveMatrix BusinessWorks applications fail at run time in TIBCO Cloud
40464 Integration if they consume a Flogo endpoint that has Post/Put Operations.

Workaround: None.

AMBW- Summary:null pointer exception is thrown at run time on ActiveMatrix
40010 BusinessWorks Mesh client when the organization name contains a space
character.

Workaround: When importing the ASR descriptor json file to create a Mesh client,
there is a second wizard page for customizing json file location (Change swagger
name). In that wizard page, remove the space from the folder name.

AMBW- Summary: The null pointer exception reported on clicking Binding Section in
39899 Components after the Refactoring operation.

Workaround: Post refactoring, close the Module Descriptor section and reopen it.
No popup is displayed.

AMBW- Summary:ActiveMatrix BusinessWorks Mesh Client applications fail at runtime in
39887 TIBCO Cloud Integration if they consume a Flogo Mesh Service that has Post or Put
Operations.

Workaround: None.

AMBW- Summary: The collectappnodedata command is not working on the AIX platform.

39837
Workaround: None.
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Key

AMBW-
39804

AMBW-
38593

AMBW-
38580

AMBW-
37714

AMBW-
37594

AMBW-
36990

AMBW-
34416

Description

Summary: SVN compare with revision option doesn't work for any revision other
than the base revision.

Workaround: None.

Summary: Condition fails to evaluate completely when you try to equate a
boolean value to a string.

For example:-If an expression is $DataGen/group/bool2 != "false™, where the bool2 is
true()

Workaround: Simply update "false" to false() or 0 and run the project. It runs as
expected (or vice-versa if its equated to "true" value)

Summary:Transition configuration error for specific customer projects.

Workaround: When a project has the Invalid expression value: [: not a Boolean]
error, complete the transition by equating it to either "true" ("1") or "false" ("0")
and run the project.

Summary:Local Transaction group option is not present in the drop-down list
present for the Group Type field for a group.

Workaround: User should ungroup the existing group and create a new group.

Summary: Breakpoints are not working when execution flow goes from one
process to another.

Workaround: Select an activity where debugging with the breakpoint is halted. It
enables the Resume button. Click the button to resume debugging.

Summary: When you delete a module shared variables or job shared variables
from the Unused Resources view, then the editor for module shared variables or
job shared variables does not get refreshed automatically.

Workaround: Close the module shared variables or job shared variables editor and
open it again.

Summary: Failed to connect to AppNode using SSH client

Workaround: Use HTTP client. Preferred way is using curl.
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AMBW- Summary: Incorrect trace is generated for the invoke process with default jaeger
34404 properties.

Workaround: Set JAEGER_SAMPLER_TYPE=const, and JAEGER_SAMPLER_PARAM=1

properties in the AppNode or AppSpace config.ini file.

AMBW- Summary: Clicking Help Contents shows HTTP ERROR: 500 error.

34396
Workaround: None

AMBW:- Summary: An application fails to start in TIBCO Business Studio™ for
34343 BusinessWorks™ when you install the latest EMS driver.

Workaround: Restart TIBCO Business Studio for BusinessWorks.

AMBW- Summary: The user will not be able to create the references for the custom
32761 operations such as Merge, Update, Trace using the drag and drop swagger file
approach.

Workaround: Users can create the references for the custom operations using the
REST Reference wizard.

AMBW- Summary: Ungrouping nested groups created inside a Catch block of a group may
28941 not ungroup as expected.

Workaround: None
AMBW- Summary: The tibco.bw.sample.policy.samlicredentialmapping.SoapHttpBinding sample fails
28663 intermittently with the error: com.tibco.governance.agent.action.ActionException.

Workaround: None

AMBW- Summary: When a process property is renamed , the change is not reflected in the
28378 activity and an error is displayed.

Workaround: None
AMBW- Summary: WSDL interface fails to resolve correctly if multiple WSDLs share the

28319 same target namespace and the SOAP invoke is created with an external binding
reference.
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Key

AMBW-
28264

AMBW-
27253

AMBW-
25219

AMBW-
25073

AMBW-
24508

AMBW-
19746

AMBW-
19540

Description
Workaround: Instead of an external reference binding, use binding reference.

Summary: When groups with the On Catch, Catch All and the OnEvent faults are
created inside a constructor or a proxy operation, the activities inside them are lost
after ungrouping.

Workaround: None

Summary: The Identity Provider field in the WSS Consumer policy resource does
not support module properties.

Workaround: None

Summary: Multiple End activities use the same variable in TIBCO ActiveMatrix
BusinessWorks™.

Workaround: None

Summary: The option to test connections, for example JMS or sFTP, in a shared
resource that has a profile is not supported in TIBCO Business Studio for
BusinessWorks.

Workaround: Specify the server configuration details as literal value or module
properties.

Summary:TIBCO-THOR-FRWK-CMN-500001:Error while renaming bundle file to final
location: - error could be displayed due to low disk space.

Workaround: None
Summary: When you initialize the module shared variable of XSD type with the
select value option to point the XML instance, application fails to start at run time.

Workaround: Enforce the default encoding of AppNode JVM to UTF-8 by adding -
Dfile.encoding=UTF-8 in the bwappnode.tra file.

Summary: When a project contain abstract and concrete WSDL using same target
namespace, a validation error is generated.

Workaround: None
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AMBW- Summary: The ability to reference from a standalone (external) schema to an
18459 inline schema is not supported. If your project contains such a reference, a

validation error is generated.

Workaround: Externalize the WSDL-inline schema and change the import
statements to reference the newly created (external) schema.

AMBW- Summary: The OSGi configuration properties have been aligned between the

17562 debug environment launched from within TIBCO Business Studio for
BusinessWorks and the AppNode that is launched in an installation. However, a
difference in behavior of the osgi.compatibility.bootdelegation property in both the
environments has been observed.

Workaround: None

AMBW- Summary: The first attempt to change the data type of an Operator's input or
16256 output schema element fails and the change is not committed. Subsequent
attempts complete without any failure.

Workaround: To commit the change, you must press the return key after every
change.

AMBW- Summary: Unable to enter an XPath expression on a transition using the XPath
14861 Builder. This issue is observed on Mac OS only.

Workaround: Enter the XPath expression directly in the Properties tab >
Expression field for the transition without using the XPath Builder.

AMBW- Summary: Under certain circumstances, substitution types do not resolve properly
12490 in the mapper. The mapper shows errors for them.

Workaround: Try closing and reopening the project. If that does not solve the
issue, try closing and reopening Eclipse. If the errors still persist, perform a project
clean (that is, go to the Project menu and click Clean...).

AMBW- Summary:TIBCO Business Studio for BusinessWorks crashes occasionally on
11534 Windows 2012 R2 platform when switching workspace from File > Switch
Workspace.

Workaround: Retry by switching the workspace.
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Migration

This topic lists the Known Issues related to Migration.

Key Description
AMBW:- Summary: After migration, a path is not executed that leads to the difference in
40387 output.

Workaround: In TIBCO ActiveMatrix BusinessWorks™ 5.x the transition condition
$Map-Data/ConditionType[last()] is treated as boolean but not in ActiveMatrix
BusinessWorks™ 6.x as ActiveMatrix BusinessWorks™ 6.x has strict validations.

In order to resolve this, please update the condition as follows:
count($Map-Data/ConditionType[last()])>0
AMBW- Summary: Migration of custom icon for the Call Process activity is not supported
40187

Workaround: After migration, manually browse the custom icon field value for
the Call Process activity.

AMBW- Summary: While migrating a project using XPATH language for transitions option,

39231 which is set to XPATH 1.0 by default, on the Migration Wizard, the Process inline
namespace schema collision issue occurs intermittently after migration is
complete.

Workaround: Navigate to the faulted process and add the missing schema
location field next to the namespace.

AMBW- Summary: While migrating a project using the XPATH language for transitions

39230 option, which is set to XPATH 1.0 by default, the service agent process migrates
as an empty process thereby throwing the Argument Cannot Be Null exception
upon trying to view that process post Migration.

Workaround: Migrate that project in a different workspace, because the issue is
intermittent.

AMBW- Summary: Post migration, a schema cannot refer the .WSDL file in it and if you
36094 try to run the project, the Schema not found error is displayed at the run time.

Workaround: Copy the inline schema that gets created post migration of the
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project and paste it into the .WSDL file.

Remove the inline schema dependency from the dependencies section and in the
input editor of the inline schema activity, re-map the point to the inline element.
After this remove the inline schema that is empty and execute the project.

AMBW- Summary: After migration, if the migrated project contains any SOAP service or
36077 client binding that uses SOAP RPC Encoded arrays, the following WSDL validation
error occurs:

WSDL In-line schema SOAP encoded array type error. In-line schema in WSDL file
contains SOAP encoded array type which requires a fix pattern.

Workaround: Download the SOAP Encoding schema from
'http://schemas.xmlsoap.org/soap/encoding/', and put it into the ActiveMatrix
BusinessWorks project.

AMBW- Summary: The migration tool does not support external schema for multi-part
35926 message in the bindings.

Workaround: Create wrapper schemas for all multi-part messages of WSDL.
AMBW- Summary: Currently, only copy-of mapping is supported for context mapping of
35899 headers.

Workaround: You can either create One-to-one mapping manually or use a copy-
of option for context mappings.

AMBW- Summary: After migration, additional round brackets in the names of the folder
33749 for externalized schema creates issues at run time.

Workaround: Remove the special characters after migration in the folder names.

AMBW- Summary: A schema cannot contain two global components with the same
30656 name.

Workaround: Modify one of the schema namespaces or element names, so that
the names are unique.

AMBW- Summary: After migration, the input mapping for the End activity which refers to
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30476 a multi-part WSDL message displays validation errors.

Workaround: A WSDL message is not supported by a mapper. Create a new .xsd
schema element with the structure similar to associated WSDL message, and then
map the schema element in place of WSDL message.

AMBW- Summary: The TransformXML activity from ActiveMatrix BusinessWorks 5.x did
26746 not migrate correctly if the Input/Output style of the activity was set to TREE in
the ActiveMatrix BusinessWorks 5.x project.

Workaround: None

AMBW- Summary: When you migrate an TIBCO ActiveMatrix BusinessWorks 5.x project
14547 containing in-built functions in the JDBC Query activity, an Invalid Column name
error is thrown in the JDBC Query activity.

Workaround: Use an Alias instead of the in-built functions in the ActiveMatrix
BusinessWorks 5.x project.

AMBW- Summary: After migration, the output of project with REST and JSON palette
14295 activities does not match with the input of the other activities in the migrated
project.

Workaround: None

AMBW- Summary: Shared resource module property references in the migrated TIBCO
13683 ActiveMatrix BusinessWorks 5.x projects do not show up correctly on non-
Windows platforms.

Workaround: Close and reopen the project.

AMBW- Summary:ActiveMatrix BusinessWorks 5.x projects with SOAP headers
9969 configuration in SOAP activities are not properly migrated to ActiveMatrix
BusinessWorks6.x.

Workaround: SOAP functionality in ActiveMatrix BusinessWorks6.x is achieved
through SOAP Binding where its detail configuration is outside of ActiveMatrix
BusinessWorks Process. The SOAP headers definition are defined at the Binding
configuration and configured as generic context parameters for the Process. In
the Process, you can use the Get Context activity (from Basic Palette) to retrieve
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Description

and process the headers as context data. You can do this manually to complete

the migrated project.

Palette

This topic lists the Known Issues related to Palettes.

Key

AMBW-
46027

AMBW-
43566

AMBW-
43361

AMBW-
36777

Palette HTTP
Description

ActiveMatrix BusinessWorks does not throw an exception for the invalid HTTP
header value sent by the HTTP service.

Summary: Error occurred when Minimum QTP Threads and Maximum QTP
Threads values in the HTTP Connector resource are set as one.

Workaround: If Minimum QTP Threads value is set as one then set the Maximum
QTP Threads value greater than one.

Summary: Performance degradation is observed with Java 11 platform while
using SSL configuration with Mutual Authentication.

Workaround: None.

Summary: Error occurred on the Send HTTP Request activity with HTTP Client
shared resource using HTTP1 Apache HttpComponents and connector SR using
HTTP 2.0 with Follow HTTP1 Compliance checked.

Workaround: Use the Jetty client as the client library for implementation under
HTTP Client shared resource.
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AMBW-
13526

Key

AMBW-
36229

AMBW-
23464

AMBW-
23260

AMBW-
23193

AMBW-
20130

AMBW-
14624

JAVA Palette
Description

Summary: In Java To XML activity, the Output tab is not populated correctly, if
Java class contains nested object references in different classes.

Workaround: None.

JDBC Palette
Description

Summary: Unnecessary error logs are displayed in the log file.

Workaround: None

Summary: The Oracle DataDirect driver does not support cursor datatype.

Workaround: Use native drivers instead of DataDirect drivers.

Summary: MySQL Community Edition is not supported for Data Direct drivers

Workaround: Use native drivers instead of DataDirect drivers.

Summary: When using DataDirect drivers with the JDBC shared resource, that is
linked to a JDBC process, the SQL Builder Wizard does not work correctly.

Workaround: Use native drivers.

Summary: The login timeout value is not effective when connecting to a Windows
OS database. The JDBC Query activity fails with the
error,JDBCConnectionNotFoundException at runtime without honoring the Login
Timeout value specified in the JDBC Connection Shared Resource.

Workaround: None

Summary: The Set Explicit Nil check box for Objects and Collections in JDBC
Call Procedure activity is disabled.

Workaround: None
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JDBC Palette

Key Description
AMBW- Summary: When you migrate an TIBCO ActiveMatrix BusinessWorks™ 5.x project
14547 containing in-built functions in the JDBC Query activity, an invalid column name

error is thrown in the JDBC Query activity.
Workaround: Use an Alias instead of the in-built functions in the ActiveMatrix

BusinessWorks™ 5.x project.

AMBW- Summary: Using any in-built function in JDBC Query activity without "Alias" fails
11667 to execute the application and throws an Invalid Column name error at run time.

Workaround: Use "Alias" to work with any in-built function in JDBC Query

activity.
AMBW- Summary:TIBCO Business Studio for BusinessWorks stops responding when
11624 opening SQL Builder if the database details on the JDBC shared resource are
changed from PostgreSQL to MySQL after a query has been created using SQL
builder.

Workaround: None

AMBW- Summary: The localized error messages of JDBC connection are not displayed
8855 correctly in TIBCO Business Studio for BusinessWorks.

Workaround: None

JMS Palette

Key Description
AMBW- Summary: ActiveMatrix BusinessWorks does not support parsing the Date-Time
38735 elements in the JMS application properties schema.

Workaround: TIBCO recommends not to use such elements in the JMS
application properties schema.
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XML Palette

Key Description
AMBW:- Summary: Use of pipe(union) ('|') character in XSLT throws the following error at
31813 runtime:

com.tibco.bw.palette.xml.runtime.fault. XMLTransformException: Exception
[org.genxdm.xpath.v20.err.ConcreteErrException] occurred during XSLT
transformation. Exception detail [org.genxdm.xpath.v20.err.ConcreteErrException:
[XPTY0004] Either the expression has a static type that is not appropriate for the
context in which it occurs, or the dynamic type of the value does not match the
required type.]

Workaround: Open the XSLT file and manually convert the pipe (union) ('|')
operator to "or" operator and run the project

AMBW- Summary: The Parse XML activity displays blank ErrorCode and ErrorMessage for
14292 activity output data validation error.

Workaround: None

REST and JSON Palette

Key Description
AMBW- Summary: The Parse JSON activity fails to pick up the prefixes defined in the
28795 namespace registry and provides the output with the default namespace prefixes.

Workaround: None

Policy

This topic lists the Known Issues related to Palettes.

Key Description

AMBW- Summary: Marketo plugin container edition breaks with the recent JRE upgrade.
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34607 Workaround: Please refer Marketo plug-in documentation for more information.

AMBW- Summary: If a SOAP binding is not configured with Transport, the Add New

19513 Policy icon should be disabled, the Policy field should not be displayed in the
tree view, and a NULL pointer exception is generated if you try to add a policy on
the binding.

Workaround: None
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TIBCO Documentation and Support Services

For information about this product, you can read the documentation, contact TIBCO
Support, and join TIBCO Community.

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation
website, mainly in HTML and PDF formats.

The TIBCO Product Documentation website is updated frequently and is more current than
any other documentation included with the product. To access the latest documentation,
visit https://docs.tibco.com.

Product-Specific Documentation

Documentation for TIBCO ActiveMatrix BusinessWorks™ is available on the TIBCO
ActiveMatrix BusinessWorks™ Product Documentation page.

To directly access documentation for this product, double-click the following file:

TIBCO_HOMEIrelease_notes/TIB_BW_6.8.1_docinfo.ntml where TIBCO_HOME is the top-level
directory in which TIBCO products are installed. On Windows, the default T/IBCO_HOME is
C:\tibco. On UNIX systems, the default TIBCO_HOME is /opt/tibco.

The following documentation for this product is available on the TIBCO ActiveMatrix
BusinessWorks™ page:

The following documents for this product can be found in the TIBCO Documentation site:

TIBCO ActiveMatrix BusinessWorks™ Release Notes

TIBCO ActiveMatrix BusinessWorks™ Installation

TIBCO ActiveMatrix BusinessWorks™ Application Development

TIBCO ActiveMatrix BusinessWorks™ Bindings and Palettes Reference
TIBCO ActiveMatrix BusinessWorks™ Concepts

TIBCO ActiveMatrix BusinessWorks™ Error Codes

TIBCO ActiveMatrix BusinessWorks™ Release Notes


https://docs.tibco.com/
https://docs.tibco.com/products/tibco-activematrix-businessworks
https://docs.tibco.com/products/tibco-activematrix-businessworks
https://docs.tibco.com/products/tibco-activematrix-businessworks
https://docs.tibco.com/products/tibco-activematrix-businessworks

89 | TIBCO Documentation and Support Services

e TIBCO ActiveMatrix BusinessWorks™ Getting Started

e TIBCO ActiveMatrix BusinessWorks™ Migration

» TIBCO ActiveMatrix BusinessWorks™ Performance Benchmarking and Tuning
e TIBCO ActiveMatrix BusinessWorks™ REST Implementation

e TIBCO ActiveMatrix BusinessWorks™ Refactoring Best Practices

e TIBCO ActiveMatrix BusinessWorks™ Samples

How to Contact TIBCO Support

You can contact TIBCO Support in the following ways:
e For an overview of TIBCO Support, visit http://www.tibco.com/services/support.

» For accessing the Support Knowledge Base and getting personalized content about
products you are interested in, visit the TIBCO Support portal at
https://support.tibco.com.

 For creating a Support case, you must have a valid maintenance or support contract
with TIBCO. You also need a user name and password to log in to
https://support.tibco.com. If you do not have a user name, you can request one by
clicking Register on the website.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee
subject matter experts to share and access their collective experience. TIBCO Community
offers access to Q&A forums, product wikis, and best practices. It also offers access to
extensions, adapters, solution accelerators, and tools that extend and enable customers to
gain full value from TIBCO products. In addition, users can submit and vote on feature
requests from within the TIBCO Ideas Portal. For a free registration, go to
https://community.tibco.com.
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Legal and Third-Party Notices

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH EMBEDDED
OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR PROVIDE LIMITED
ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE EMBEDDED OR BUNDLED
SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY OTHER TIBCO SOFTWARE OR FOR
ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND CONDITIONS OF A
LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED SOFTWARE LICENSE AGREEMENT,
OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER LICENSE AGREEMENT
WHICH IS DISPLAYED DURING DOWNLOAD OR INSTALLATION OF THE SOFTWARE (AND WHICH IS
DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR
CLICKWRAP END USER LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF
THE SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND
YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE
SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this
document may be reproduced in any form without the written authorization of TIBCO Software Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, ActiveMatrix BusinessWorks, ActiveSpaces, Business Studio,
TIBCO Business Studio, TIBCO Designer, TIBCO Enterprise Administrator, Enterprise Message Service,
Rendezvous, and TIBCO Runtime Agent are either registered trademarks or trademarks of TIBCO
Software Inc. in the United States and/or other countries.

Java and all Java based trademarks and logos are trademarks or registered trademarks of Oracle
and/or its affiliates.

This document includes fonts that are licensed under the SIL Open Font License, Version 1.1, which is
available at: https://scripts.sil.org/OFL

Copyright (c) Paul D. Hunt, with Reserved Font Name Source Sans Pro and Source Code Pro.

All other product and company names and marks mentioned in this document are the property of
their respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating system
platforms for a specific software version are released at the same time. See the readme file for the
availability of this software version on a specific operating system platform.
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THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. CHANGES
ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE INCORPORATED
IN NEW EDITIONS OF THIS DOCUMENT. TIBCO SOFTWARE INC. MAY MAKE IMPROVEMENTS AND/OR
CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S) DESCRIBED IN THIS DOCUMENT AT ANY
TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT
NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This and other products of TIBCO Software Inc. may be covered by registered patents. Please refer to
TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.

Copyright © 2001-2022. TIBCO Software Inc. All Rights Reserved.
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